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EXECUTIVE SUMMARY

This report is designed to provide MPQ technical staff with comprehensive technical
documentation concerning key aspects of the Transportation Data Management System (TDMS)
implemented by the team of David Plummer and Associates (DPA) and International
Development Advisory Services (IDAS). This report is to be used as a training and overall

reference manual.
Section 1 introduces the basic purpose and philosophy underscoring the creation of the TDMS.

Section 2 describes the key software platform used to build and maintain of the TDMS, including
ArcView 8.1, MS Access and HTML ImageMapper.

Section 3 details the system’s basic file structure, particularly in the context of ArcCatalog, one

of the key components of ArcView 8.1.

Section 4 details selected procedures deemed important to guide MPO staff in the various

processes of updating, maintaining and continuously expand the TDMS.

Section § describes the Access application developed by the consultants to facilitate access and

documentation to the TDMS.

Appendix A summarizes various notes and tables prepared, as part of the training, by the MPO

technical staff.
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1.0 INTRODUCTION

The objective of this project was to develop and implement a flexible, expandable, computer-based
electronic database. The database now resides at the Miami-Dade Metropolitan Planning
Organization (MPO). The database holds transportation-related information that allows statistical,
temporal, and geographic analyses. This data has been assembled into a product called the
Transportation Data Management System (TDMS). The system is capable of generating reports in
tabular, chart and/or map formats. The information in the system can then be used in reports,

handouts, presentation exhibits, electronic presentations, and/or for publishing onto the Internet.

1.1 Background

A disparate array of information in a variety of formats and assorted media were available from
numerous locally involved federal, state, and local public and private agencies. Travel demand model
input data, and limited output data were available in yet other formats. Various efforts are being
pursued by other agencies. However, there was no central location capable of making these data

avatlable.

1.2 Purpose of This Report
The purpose of this report is to provide a training manual to MPO technical staff in support of their

continuing system maintenance and updating requirements.
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2.0 TDMS COMPONENTS

Various hardware and software components were assembled as part of the overall TDMS project

implementation.

2.1 Hardware

Project funds were applied to the purchase of the following hardware equipment:

* Dell Computer Dimension 8100 workstation, Intel Pentium 4 processor operating at 1.5 GHz,
384 MB of RAM, an 80 GB SCSI hard drive, a 64MB graphics card, a 32x CD-ROM
writer/reader, and a 48X CD-ROM reader. Its operating system is MS Windows 2000, with Dell

integrating MS Office 2000 Professional as part of the package.

It is noted that this workstation was used during system development to ensure proper installation
of all the peripheral hardware, software and data. This approach provided ample opportunity for
testing the system in its entirety to further assure the MPO that the system was fully operational
at project completing when the system was turned over to the MPO. The computer was also used
for the continuous hands-on training of MPO personnel. The training, therefore, was done under

the exact same setup that the system will have at project completion.
* LCD Projector - Epson PowerLite 505¢ for presentation of maps and graphs.

» Scanner - Hewlett Packard ScanJet 6300 with document feeder for digitizing information not in

electronic format.

¢ Digital Camera, including Case and Wide-angle Lens - Sony Cybershot DSC-F707 for acquiring
digital photos to be included in the TDMS database.
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2.2 Software

This project included the acquisition and installation of original licenses for the core software that
comprise the system. The software was installed in the system computer and fully tested prior to

delivering the computer/software system package to the MPO.

These core software programs include ArcView GIS 8.1, Access 2000 and HTML ImageMapper 8.1.
Selection of this core software was driven by factors such as its proven reliability, ease of use, its
adoption as a standard across Miami-Dade County departments, familiarity to a wide range of users,
compatibility with most common databases, compatibility with the available source data as well as

other MPO databases.

In addition to the core software, other MS Office Professional modules, including Word, Excel,
PowerPoint and FrontPage were used at different points of the TDMS original developmental
process. These modules will be continuously used in the future, supporting the process of
incorporating, maintaining and updating data within the TDMS, and making the data usable through

maps, reports and/or charts.

2.2.1 ArcView GIS

Geographic Information Systems (GIS) software provide the primary graphical and visual analysis

component of the system.

The core software providing these capabilities is ArcView GIS 8.1, an industry-standard GIS
package developed and published by Environmental Systems Research Institute (ESRI). This latest
version of ArcView is more powerful and flexible than the previous versions, ArcView 3.x, currently

being used by the MPO.

A major improvement in the 8.1 version is the ability to readily interface with state-of-the-art

relational databases. Its native database of ArcView GIS 8.1, when used on a single desktop, is MS

Puge 3
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Access; ArcView GIS 8.1 builds “geodatabases™ using MS Access as the underlying database
engine, holding data in both spatial and tabular forms. Should the MPO eventually contemplate the
use of its TDMS by a number of concurrent users, the underlying geodatabases, originally built in
MS Access, can be easily exported to an enterprise-wide database platform, such as Microsoft’s SQL

Server.

ArcView GIS 8.1 consists of three integrated modules:

* ArcCatalog — A spatial database management interface, similar to MS Explorer, but for both
geographic and tabular data, provides the supporting spatial database, geodatabase and metadata
creation and maintenance functionality required to build and sustain a robust transportation-

oriented data warehouse.

* ArcMap — A “map-oriented” Graphical User Interface (GUI) provides an extensive set of state-
of-the-art data selection, querying and display tools, as well as extensive map layout tools

capable of producing cartographic-quality map products.
* ArcTools — A set of time-tested spatial analysis and management tools complimenting the two

principal modules, Ar¢Catalog and ArcMap.

In addition, the out-of-the-box capabilities of ArcView GIS 8.1 can be easily extended through a
readily accessible programming environment based on ArcObjects, a built-in set of programming
objects supporting MS Visual Basic as well as other industry-standard Component Object Model
(COM) based programs.

The ArcView GIS box contained, in addition to the actual software media and license, a complete set

of training manuals published by ESRI, including:

e  What is ArcGIS? ¢ Getting Started with ArcGIS

¢ Using ArcMap ¢ Editing in ArcMap
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* Using ArcCatalog ¢ Using ArcToolbox
e Building a Geodatabase ¢ Understanding Map Projections

» Design Modeling Our World — The ESRI ¢ The ESRI Guide to GIS Analysis — Vol.

Guide to Geodatabase I: Geographic Patterns & Relationships

e Getting to know ArcGIS

Some of these manuals were used extensively to support the initial training of MPO technical staff,
and will remain available to the MPO for future consultation. Other manuals present advanced
topics not covered in the initial basic training. It is strongly recommended that MPO technical staff,
as part of the process of refreshing, maintaining and expanding their skills in GIS, review and utilize

these manuals in an on-going and disciplined manner.

In addition to the initial training that was part of this project, ArcView training and training materials
are commonly available from many sources, including ESRI-authorized courses provided locally by

IDAS and area universities.

In summary: ArcView GIS 8.1 is extremely flexible, which makes it an ideal off-the-shelf tool that
the MPO can tailor to their specific needs as they change over time. Furthermore, the long-term
vision for future development and expansion of the ArcGIS family of programs assures a robust

system that can be expanded even further in the future if and when the need arises.

The TDMS avails itself of another GIS package, ArcView 3.2a, a license previously acquired by the
MPQO, which is also installed in the Dell computer workstation. ArcView 3.2a, also published by
ESRI, is a precursor to ArcView 8.1. Some of the procedures described in Chapter 4 rely on this

package to provide support to backbone GIS operations performed in ArcView 8.1.
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22.2 MS Access 2000

The database software used in the TDMS is Microsoft Access (2000 or the newer XP version), the
flagship desktop database package from Microsoft, included as part of MS Office 2000 Professional,

bundled with the workstation.

The industry-standard Access (2000 or XP) is a state-of-the-art relational database fully compatible
with ArcView. As a member of the Microsoft family of products; as such, it is highly compatible
with other Microsoft products such as Excel and Word. Additionally, the program is capable of
importing files from other databases and converting them into Access format. Access too, although
relatively new, is considered a mainstream program, is very flexible and adaptable to the future

needs of the MPO.

Access is also upwards compatible with enterprise-strength databases, such as Oracle and SQL-
Server. Extensive training and training materials are also available to the MPO from a multitude of

sources for the future training needs after the completion of the project.

‘The program is compatible with other MPO tools and databases including Visual dBASE. Access,
however, is more user-friendly and flexible, it has many similarities with Excel, and offers powerful
database functions in addition to charting and reporting options. Access is used to store the

transportation-related data that can be displayed and analyzed graphically using ArcView.

Furthermore, the MPO staff person charged with responsibility for maintaining and upgrading the

TDMS is fully conversant with Access, requiring little or no additional training,
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2.2.3 HTML ImageMapper 8.1

This software is an add-on extension to ArcView GIS 8.1, developed and published by Altad, a

German company partnering with ESRI.

ImageMapper is designed to allow users to develop and publish web-enabled pages containing maps
capable of zooming to pre-determined fixed increments, panned across a given extent, and querying
underlying feature attributes. Once created, these pages can be published in the Internet, across
Miami-Dade County’s intranet, or even simpler, posted in the MPQO’s computer and made accessible

to other users through the county’s Local Area Network (LAN).

The software’s relative low cost, full integration into ArcView, and easy use makes it an ideal tool

for the task of producing web-enabled “dynamic” maps.

Use of this software extension is documented in Chapter 4, and a complete User’s Manual has been

made available to the MPO as part of the software license documentation package.

2.2.4 Cross-Platform Integration

The cross-platform integration of the software components of the system is achieved at three distinct

levels, as follows:

I. The intrinsic codependence, built-in relationship between ArcView GIS and Access by virtue of
the software’s built-in ability, through its geodatabase structures, to display and manipulate data

attached to geographic features.

2. 'The second level of integration is achieved by means of a GUI application, developed in Access,
that allows access to the information through a series of screens with buttons. The screens group
the mformation by category and present various options for its use. These levels of integration

are described below.
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3. The third level is of integration is represented by the ability to create and publish web-enabled

maps through the use of HTML ImageMapper.

This integration will be transparent to most users. In essence, once certain sets of data are set-up on
the system, there are layers of information that can be turned-on from the GIS (ArcView)
environment. In other words, ArcView already knows the location of the data {as an element of a

larger database) and automatically “calls-up™ the information onto the corresponding map.

Once the data is displayed in ArcMap, a series of functions are available which allow the user to

query, select, relate, analyze, print and otherwise use the information in many formats.

When any information that is already included in the database is updated, a simple replacement of
the database file (or component) is all that is needed to make the information useable inasmuch as
ArcView already knows where the information is located and how to display it. When new
information is added to the database, the information must first be set-up by creating the layers that
define how the data is attached to particular geographic features. This process does take several steps

to complete, but is a very common function that quickly becomes an automatic routine.

Changes in the underlying data may require modification of the previously-created web-enabled
pages. As an extension to ArcView, HTLM ImageMapper 8.1 is always available to easily create

new pages, seamlessly replacing outdated ones.

Direct use of ArcView provides access to all the powerful functions built-into the GIS software.
However, this method of accessing the data does require a certain level of ArcView and Access

knowledge, as well as a proper understanding of the data available and its location.
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Another method of accessing the data is through the MS Access application developed as part of this
project and described in Chapter 5 of this manual. Users with little or no previous knowledge of GIS
and/or databases can use this application to gain valuable information about key aspects of the

TDMS and its database, mapping, reporting and web-enabled components.

2.2.5 Metadata

The ArcView software formalized the process of creating and maintaining metadata within the

software’s ArcCatalog module.

Throughout the TDMS design and implementation, special care was given to the issue of
documenting the data underlying the system, what is usually referred to as “metadata”, or “‘data
about data”. Ensuring that the TDMS data complies with widely recognized metadata standards is a
key and necessary element of this process. All spatial and tabular data incorporated into the TDMS
underwent an extensive process of documenting the metadata, namely the data’s sources, time of
creation, applicable coordinate system, attribute definition, data scope and limitations, in short, all of
the data’s metadata. Key components of this process are presented in Section 4.x (Chapter 4) of this

report.

Maintaining this metadata component up to date is essential in order to maintain the system fresh and
valid, thus avoiding a gradual deterioration in the quality of the data. We strongly recommended that
MPO staff in charge of updating the validity and freshness of the system’s data ensure that the strict

metadata standards are rigorously followed over time.
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3.0 TDMS FILE STRUCTURE

The MPO’s Transportation Database Management System (TDMS) has been organized within an

integrated, rational file structure under the directory MD-MPQ-TDMS in the primary C: drive of the

MPO computer.

All the readily available data, in the appropriate format, has been loaded into that directory from
multiple sources. Future data, new and/or updated, can be input through a variety of conventional
media such as floppy disc, CDs, as well as through the computer’'s communications port, which is
capable of providing direct access to and from other computers at the MPO, the Internet and the
Miami-Dade Intranet. Additionally, images can be imported into the computer from the scanner and

the digital camera via USB ports.

Output from the system can be generated and stored in safely-located back-up files. Additionally,
paper output can be generated using the color and/or black and white printers and plotters already
available at the MPO. The system software packages also have wide flexibility with the format of

input and output files. In some cases the format of some files may be converted to another format.

The CAMD-MPO-TDMS directory has three main subdirectories and one Access-based application,

as shown in Exhibit 3.1, below right, a screen shot from ArcView GIS 8.1 ArcCatalog.
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|. DataStore: This subdirectory functions as the systems overall fgifmmqms
=i {54 DataStore
data repository. w: (23 Charts
i Data
2. Help System: Holds help files used by the system. e e ations
r+— Reports
3. ModelsAndApplications: Stores specific models and b (3 webPages
l-.*__ B dotioge
applications developed by the system. - %a"‘m—‘
=-{Z3 ModelsandAppiications
4. MPO-TDMS: The MS Access application designed to tie w: G FDOTApps
23 FSUTMS
together all elements of the system. n 5%?&5

3.1 DataStore

This subdirectory has been designed to function as the MPO’s overall transportation data warehouse.

It contains folders containing Charts, Data, Maps, Presentations, Reports and WebPages.

3.1.1 Data

This folder is designed as a data warehouse holding the entire volume of transportation-related, as

well as non-transportation support data requested by the MPO.

The Data folder is organized into its own subfolders, as follows:

3.1.1.1 Digitallmages

This folder hoids three types of digital imagery: 1) digital photos related to transportation projects,
some of which were obtained with the digital camera recently acquired by the MPQO as part of this
project; 2) digital plans and drawings, mostly obtained by scanning paper documents; 3) digital
ortho-corrected aerial and/or satellite photography of Miami-Dade County. Exhibit 3.2 below shows

the basic organization of this folder:
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! hocation: [FiCataStone\D ata Digital mages DigtaiPhatos
i 'Stleshoet TR =1 £ ST e L
S - “Gontants [ Proview | Motadata ]
= Digitad Irmna : b
- (:3_-, &y Dﬂa:::tﬂf maynebm.llevud&lehmancauseway Raster Dataset
#i B biscaynsbauteyardidehmancauseway i ocidengladescameras Raster Datasot
: goldengladescameras ﬁi—gs northbound at key biscayne exit Raster Dataset

95 northbound at key biscayne exit
j 95 southbound at key biscayne exit
B lohman causeaway
mcarthur causeway waestbound
opa locka arport
ovarpass construction at w 43 st
SRE36 and NW 17 Ave westbound 19908
=i lﬂ Digit alPlansAndDr awings

£ goldengladesrander g

142 US1 Flyowver drawing
= £ Crthos
R-mrict. sid
ITDOMrSidAaerial

s

o

ﬁi—gs sourhbound at key biscayvns sxit
ﬁlehman causavay
m mcarthur causeway westbourd
u opa locka airport
ovarpass construction at w 49 st
ﬂ SRB3E and NW 17 Ave westbound 1998-05-07

@;

Rastar Datasat
Rastar Dataset
FRastar Datasst
Raster Dataset
Raster Datasst
Raster Dataset

It is noted that the open architecture nature of the system allows unlimited storage of these digital

photographs, as well as further specialized organization.

1. DigitalPhotos: Exhibit 3.3, at right, shows
a list of digital photos currently stored in
this folder, plus a preview of one of these
(Biscayne Blvd. & Lehman Causeway).

2. DigitalPlansAndDrawings: Plans, draw-

ings and renderings of future projects/
developments, as shown in Exhibit 3.4, at

right.

65 southbound 2 key Discayne ext
¥ B mearthur causeway westhound

¥ gkl OVOrDASS ConStruction of w 49 st
ﬂBﬁlﬂWl?Mw&ﬁbﬂﬂllm—Iﬁé

&
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3. DigitalOrthoPhotes: This folder holds ortho-corrected aerial digital photos as well as selected

satellite imagery for Miami-Dade County, which can be used as backdrops for maps produced

through the TDMS.

tondiak - [EWD D TOMS Daiabioe Caalbor e s i, 1

Exhibit 3.5, at right, shows a list of ortho-

corrected digital photo files currently stored in
this folder. It also shows, in preview, a
zoomed-in shot of downtown Miami from
black-and-white ortho-corrected aerials
commissioned by the Miami-Dade Information

Technology Department (ITD) to be used by

local agencies in their GIS-related projects.

$ Lpoabon: . JCMOMPO-TOMSD

i Cakalog
= 3 CAME-MPO-TOMS.
i~ &4 DataStore:

Exhibit 3.6, at left, shows a LandSat 5 color
(multi-spectral) satellite photo of the central

Miami area.

3.1.1.2  PIDES

This folder is designated to hold the entire inventory of non-transportation data currently available
for Miami-Dade County. As an acronym, PIDES stands for “Physical, Institutional, Developmental,

Environmental and Socic-economic™ data.
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The open architecture of ArcCatalog allows with ease the updating of feature classes within existing
geodatabases, for future data to be easily added to the corresponding geodatabases, and for the fast

creation of new symbolized layers.

This folder is divided into several sub-folders, each containing the corresponding data in the form of

geodatabases and symbolized layers. It is noted that:

e Geodatabases contain in a single ArcGIS/Access database, all spatial and tabular data defined for

a given folder, as detailed in Section 2.2.1.5 (previous chapter).

e Symbolized layers are thematic representations of a given feature class within the corresponding

geodatabases, as detailed in Section 2.2.1.6 (previous chapter).

3.0.1.2.1 Physical

As previously indicated, this folder holds all physio-hydrographic data for the County. The folder
contains a geodatabase named “Physical”, which contains separate symbolized layers, each
corresponding to a feature class within the geodatabase. Individual feature classes and symbolized

layers, as shown in Exhibit 3.7 below, include:

¢ County Boundary, outline, i or . {CAMDHPO-TOMS\DetoSters\DatePDES\Physicd

shoreline m
GTvpe. .o

e Contours ifw'g' v
Layer
» Hydrography (rivers, Layer
lakes, streams, canals) tx
¢ Flood Hazard Zones t“’“
ayer
. . Lw
e Hurricane Evacuation Layer
Zones e Layer
Layer
¢ Soil Conservation Layer
Layer
Layer
Layer
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3.1.1.2.2 Institutional

This folder contains all available institutional data as a geodatabase named “Institutional” and
separate symbolized layers, each corresponding to a feature class within the geodatabase. Individual
feature classes and symbolized layers, as shown in Exhibit 3.8 below, include, among multiple

others:

County Commission Districts

Municipal Boundaries

Major County Neighborhoods ‘ . Pl e et
o & CommissonDistri Personal Geodatabase FeatL

Senate and House Districts _ P Personal Geodatahase Featr
_ : Persondl Geodatabace Festy

Team Metro Boundaries/Offices 3 - Personal Geodatebase Fiatt
Parsonal Geodatabass Feat

Empowerment Zone(s) . - Persoral Gaodatabase Featy
Boundaries j j Personal Geodatabase Feat,
. oy . ' & Personal Gendatabase Feat.
Fire Board Districts, Fire : , ; Personal Gaodatabase Frahy
Stations, Fire Dept. Grid, ' i Personal Geodatabase Featt
Rescue/Suppression Response ' Porsonal Geodatabase Fea

Service Areas

Police Districts, Patrol Areas,
Grids

Parks Dept. Districts, Parks

: ) . ... Porsona Gaadatabase Faah
Hospitals, Libraries Persond Geadatabse Fat,
) ) Personal Geodatatase Faatt
Polling Precincts  Persoral Geodatabuse Fast,
Persordl Geodatabase Featy

Schools, Public/Private Personal Geodatabase Featy
Persenal Geodtabasa Featt

WASA Service Areas, Solid o Persone Geodtabase el
Waste Management. Pickup Porsna Gencabase Fedt
Routes Personal Geodatahags Feah,
Personal Geodatetase Feat

PersonalGeadatabase Featy
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3.1.1.2.3 Developmental

This folder contains all available development-oriented data as a geodatabase named
“Developmental” and separate symbolized layers, each corresponding to a feature class within the
geodatabase. Individual feature classes and symbolized layers, as shown in Exhibit 3.9 below,

include:

o Cable/TV Service Areas
5 Fe Ed Yo @ Tooks Hep

¢ Mobile Home Parks H-) m m a Xy
&&‘, N O ry %’jﬁa
|cwnummu5\o.a.smw¢mnsswww _

e Telecommunication Sites

3.1.1.2.4 Environmental

This folder contains all available environmental-oriented data as a geodatabase named
“Environmental” and separate symbolized layers, each corresponding to a feature class within the
geodatabase. Individual feature classes and symbolized layers, as shown in Exhibit 3.10 below,

include:

¢ Dumps

e Hurricane Evacuation Zones

¢ Hurmmicane Shelters

e Well Fields

{2 Harrkanesheters ’ @ HarkaneEvacustionZones Evac_...  Layer
] welleids " 1% Huricannshekaes Layer
Dumps €3 wolfiekds Layer
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3.1.1.2.5 SocioEconomic

This folder contains all available socio-economic data as a geodatabase named “SocioEconomic™ and
separate symbolized layers, each corresponding to a feature class within the geodatabase. Individual

feature classes and symbolized layers, as shown in Exhibit 3.11 below, include:

e Census Boundaries (Tracks, Locators [THDHPU-TOMS DstaStore\DaaiPIDES SoooE concmc
Enumeration Districts, Blocks) == s = X! Caterts | Preview| Metacaa |
) . =+ SodoEgnome a4 .
s Metropolitan Statistical Areas = ™ socoEconomic Name iTpe.
(MSAs) . [ AutosEmploymentsandcon | Wsocckcononic Personal Geodatabase
" B sockstnft gmm Lover
: . Bl CensuslockFromSirests CensusBlockFromStreets Layer
* Zip Codes " B ComsusBiockarows gcmm Layer
i i i . B Censustlocks CansusBlocks Layer
¢ Vehicle Registration morsta | & - e
¢ Autos, Employment and m _ ngasPlaces Layer
. . i [{
Economic Ranking (FSUTMS) B ConsusTrots egxl:zsscom m
. . (&0 fral and_bousi "
e Population, Housing and | gM.l999'_;74:%1:‘;tms gmmmmeas ﬂ
Employment (FSTUMS data) gwﬁwm

3.1.1.3 TransSys

This folder is designated to hold the entire inventory of transportation data currently available for
Miami-Dade County. The open architecture of ArcCatalog allows with ease the updating of feature
classes within existing geodatabases, for future data to be easily added to the corresponding
geodatabases, and for the fast creation of new symbolized layers. This folder is divided into several
sub-folders, each containing the corresponding data in the form of geodatabases and symbolized

layers. It is noted that:

e Geodatabases contain, in a single ArcGIS/Access database, all spatial and tabular data defined

for a given folder, as detailed in Section 2.2.1.5 (previous chapter).

e Symbolized layers are thematic representations of a given feature class within the corresponding

geodatabases, as detailed in Section 2.2.1.6 (previous chapter).
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3.0.1.3.1 Tl (Transportation Infrastructure)

This folder holds all data related to transportation infrastructure. The folder contains a geodatabase
named “TI” and separate symbolized layers, each comresponding to a feature class within the

geodatabase. Individual feature classes and symbolized layers, as shown in Exhibit 3.12 below,

include:
e Bike Lanes. Paths and ~ teson.  EHDMPOTONS\Dsa5toeatalTranss s T 4
* e e e s e emenemu e e s e e s e e e el e e ie e e es e e e e e e e ne veie e L
Bikeways & e
* Bus Routes *%f’“m Perscnd Geodatabase Fosture Class
BkaPaths Perscnal Geodatabase Feature Class
e FDOT Basemap (not & BhowayCondioes Pesonal Geodatabase Feature Class
BusRouteswithBkeR acks Personal Geodatabase Feature Class
enabled for DynSeg) Sre oesonal Caodatabase Festrs Clace
. FloridalntrattaterighwaySystain Personal Gegdatabase Faaturs Clacs
» Florida State Roads FordaStateRoads Personal Geodetbess Feature Clas
System FunctionalClessFedes skural Persaral Geodatobase Featurs Cless
Functional lassFeder aLrban Fersonal Geodatabase Festure Class
¢ Functional Road Hgways Forsoral Geodstabase Featurs Class
Classificati IntermodalFacities_points-Type_of_TE Personal Geodatabase Festura Class
assifications “’Wﬂﬁm Parsonal Geodatabase Feature Class
ig e Ikermodal acfhies Fersonal Geodatabase Fosture Cless
¢ [ntermodal Facilities Intermodaackties pely Pavsonal Geodatabass Featurs Class
ngm Personal Geodatabase Feature Clss
¢ Street Network MajorRoads Funclass Parsonal Geodatabass Feature Class
gn\l}ukoads-Tnxk_Cude ol “oaca Fosro Cls
. jorRoads Personal Geodat, u Class
¢ Major Roads @ Sustonts Pevsonal Gendatabase Feature Cless
Stroethetwork
e State Roads TraffeSqnasFDOT
TrafficSionals¥DITD- TimingZone
. . TrafficSignalsMDITD
¢ Traffic Signals TS o

The user can exploit ArcCatalog’s capabilities to further explore the individual characteristics of any
feature class. As an example, the user may wish to explore the "MajorRoads™ feature class within
the TI geodatabase. After opening TI, one would then click on the MajorRoads class, then clicking
on the Preview Tab, would select “Geography”. ArcCatalog will present the following (Exhibit
3.13):
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4
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§

1

k1

e |

&)

=

&1 BuskouteswithiskeR acks

Alternatively, by selecting “Table” mode in “Preview”, the user can review data values for that

feature class, as shown in Exhibit 3.14 below:

<EEE

1
|

gg £[E

:§ =X

=i=[§

%

z:,jaega:@m SRl

OPA LDCKA

Page 19



Miami-Dade MPO
Transportation Dara Managemernt System - Training Manial

Similarly, by clicking on the “Metadata” tab, the user can view, edit and update the feature class’

metadata!, as shown in Exhibit 3.15, below.

! Lacaion: icwoum TDMS\DdaStore\Da!a\TrmsSy:‘\Tl\Tluﬁb\Maernar.h ] | Stasheet |E5F|I i 4 5 L‘__%:_; l’:a__ &

%! Canients Praview ”ﬂﬂﬂb
MajorRoads

Personal GeoDatabase Feature Class

Keywords
Theme: Dade Road Information

Description

Abstract
Incorporated into TransSys->TI Geodatabase as a line feature of Miami-Dade County

Major Streets,

Purpose
Created ta used mainly on small scale maps that would have the need to identify the

major roadways for that particular area of interest or to display the roadways on a
countywide scale map.

Supplementary Information
Data and Procedures provided by Miami-Dade ITD

Based on the Miami-Dade County Street Network, which was originally purchased from

FunctionalClassFederallrt ESRI in 1987 for the area of Dade County, ESR! purchased the data from ETAK, which
Highwiays in turn had gotten the data from the Census Bureaw in TIGER format. Then, with the
IntermodalF aciities_point: ‘@ use of ArcEdit, the arcs were aligned.

ey "‘;é alsp, after the coverage was BUILD, 1t needs to be INDEX both, on the Line and

3.1.1.3.2 TM H (Travel Mode: Highway)

This folder holds all data related to travel mode highway for the entire County. The folder contains a
geodatabase named "TM_H" and separate symbolized layers, each corresponding to a feature class

within the geodatabase. Individual feature classes and symbolized layers, as shown in Exhibit 3.16

below, include:

*/ Metadata operations are explained in detail in Section 2.x.x.x (previous chapter}.
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e AADT cain: {CMDHPO-TDMS\DalaStore\DataTiansSyTM_H
» Fatal Crashes 1997-99 15 g TS 2
= Py A : G
* FDOT Districts &3 wor B
B} Fatarashes1997 199 {Draalrashes1997_1999 byokdied  Laver
e Federal Aid Highway B Foomistricts & FDOTDistricts Disrct Laver
System [ FedaidHwysysten © FoODistricts Layer
. £} Marspeed OFsdticrwysysten Layer
e Maximum Speed &3 RoadinpadFeeDisricts B Maxspoed HaxSpeed Layer
B3 RCopacky @ Maxspeed Layer
¢ Road Impact Fee Districts & Rrunctonallaseficaon S Roarsor Layer
& srwrSectiondmpeovement @ RoadCapacty24H Layer
* SR Capacity and Q‘W""m © RoadimpacFeslitrits RF Detri  Layer
Functional Classification ‘ :Mw::?m D scapaty Laver
Gl Trffclyss2 & ReunctionalCassfication-Cassfic... Layer
. ‘B TrafficAnalysisZones2000 ) )
e SRWP Section/Structure . < —— & SReunctonalCasshcation-Cassfic... Layer
[ trafticC ountStationsFDOTRantLocations P'S .
Improvement B TrafficMritoringStations DO TLineSegments SRuPSectininprovoment Specf. - Layer
@ RuPSectirimprovement-Year L
Fatakrashes1997_1999 _byNokTled _ aye
e Traffic Analysis Districts FOOTDistricts-District @ SRWPSectionlmprovanent Layer
Py — € SRwPStructurellngrovament Com... Layer
e Traffic Analysis Zones @WMW g:mﬂ"ﬂmm taver
MaSpeed-MaxSpeed _ WrStruchrellmprovement aver
(1992 and 2000) é 'gnml Dl Loy
: ans @ RoadtaDT TrafficandysisZores 92-Dstrict ~ Layer
¢ Traffic Count Stations _ g - g“ - o
. _ RoadimpactFesDistricts A Distr TraffchnalysisZones2000 Layer
. Trsztf;icolr\l/ionltorlng ?Sf.: @ 1 & TffcontSatonsDOTonticc . Loy

3.1.1.3.3 TM PT (Travel Mode: Public Transportation)

This folder holds all data related to “travel mode - public transportation™ for the entire County. The
folder contains a geodatabase named "TM_PT"” and separate symbolized layers, each corresponding
to a feature class within the geodatabase. Individual feature classes and symbolized layers, as shown

in Exhibit 3.17 below, include:

Puge 21



Miami-Dade MPO
Transporiation Data Management Svstem - Truining Manual

e Bus Maintenance Facilities [ [CWoMmTomsoasmenasmmes v

* Bus Routes ﬂg{: .
e Bus Stops %}mm -
s MetroMover Routes & mezamover
s MetroMover Boarding % MatroMovrStations
. &g Metrora¥
e MetroMover Stations 5] MetrofaiMainenancer scikies
¢ MetroRail Routes = Roban
s MetroRail Maintenance §W
P Busitoute
Facilities Bussops
. R (MatroMover
« MetroRail Stations MatroMovarioar
Mat:oMoverStations
» Railroad et oR s s scltis
MetroR alitations
e TriRail gm’*

3.1.1.34 TM OM (Travel Mode: Other Means)

This folder holds all data related to other means of travel for the entire County, including aviation
and special transportation services. The folder contains a geodatabase named “TM_OM” and
separate symbolized layers, each corresponding to a feature class within the geodatabase. Individual

feature classes and symbolized layers, as shown in Exhibit 3.18 below, include:

e Air Facilities, including: MO-HPO-TDME DateStors Daia TraneSysiTH_OK :

o Name
o QOwner
o Use

¢ Special Transportation
Services — Zone

® Special Transportation

Services - Quantities
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3.1.1.3.5 Other

This folder 1s designated to hold all other transportation-related data not specifically linked to any
other folders. At the time of this writing, the "Other” geodatabase does not contain any feature

classes. This folder can be populated by the MPO on an as-needed basis.

3.1.1.3.6 Basemap

This folder contains an Arc/Info coverage with FDOT’s most current basemap, enabled for Dynamic
Segmentation. Users should ensure they use this coverage whenever they wish to apply DynSeg

techniques to the FDOT road network for Miami-Dade County.

3.1.2 Maps

This folder is designed as a map warehouse holding various ready-made map templates as well as

numerous special purpose presentation-quality maps prepared by MPQ staff, as shown in Exhibit 3-

19, below.

______ ) | Sveest
Hm S Meladata]
3 3 Templates Newe . o f e
" @) 11x17 County Urbarized Avea- Ste 2 ETenplates Folder
11x17 County Urbarized Area @) annual Average Dady Traffic Map Document
%llxl?OverlaﬂLmdscmeVnw-Stylez )i Paths and Lanes Map Document
- @) 11x17 Overland Landscape View Epieway CondRions Map Document
80} 11x1 7P Mostly Land ) Crash with Fatalities in State Road,.. Map Document
: § 11x17P-With Water QMO County Commission Districts ~ Map Document
CountyReference @) Metrobus System - Downtown Mia... Map Document
E-Size County Urbanized Ares with graph @ Metrobus System - Miami-Miami Be... Map Document
E-Size-4paneiComparison-TAZs @lMetrobus System - Routes Map Document
,_? w a;sm!m Daiy Traffic @ TAZ2000 with 2015 and 2025 Proj,..  Map Document
3 aNes 1 & " . .
3} Biemay Condi Trafflc Analysis Zones - 2000 Map Document
) Crash with Fatalities in State Roads - 1997-1999 '
) MO County Commission Districts :
S MetabusSystem  Douronn M- Routes snd ops b
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3.1.2.1 Templates

This folder contains a number of ready-made map templates available. The following are included in
this folder:

¢ County Reference

e 117x17” County Urbanized Areas, Styles | and 2

e [17x17” Overland Landscape View, Styles | and 2

¢ 117x17" Portrait, Mostly Land

e | 1”x17” Portrait, With Water

e E-Size County Urbanized Area, With Graph

¢ E-Size — 4-panel Comparison, TAZs

Additional templates can be easily created by modifying existing ones.

3.1.2.2 Presentation-Ready Maps

When using ArcMap, MPO staff can avail themselves of these templates simply by replacing the
feature classes and/or symbolized layers provided in the template with the ones desired for the actual

map.

3.1.3 Charts

This folder is designed to contain bar and pie charts, as well as similar graphics and charts developed
by the MPO staff from data and applications stored in any of the other TDMS folders, developed
through the factlities provided by ArcView GIS, MS Access and/or MS Excel.
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3.1.4 Presentations

This folder is designed to contain presentations developed by MPO staff using PowerPoint, Excel,

Access and other software support packages. from data and applications stored in any of the other

TDMS folders.

At the time of this writing, this folder contains the Miami-Dade Transportation

Information Y2000 Summary presentation, consisting of the following files:

¢ PowerPoint (Exhibit 3-20, right). To
run this presentation, simply double-
click on the file in Explorer.

¢ The underlying Excel file

® An Access database file with

individual tables set out for each
PowerPoint slide. To update this file
in preparation for creation of a new
simply

PowerPoint  presentation,

rename and modify the

copy,

underlying table values.

3.1.5 Reports

1 I Trandly in Popetion,
Moml-Danle

2[7] Trenls in Compononts of Papulstion Change, Mismi-Dade
3 () Trends in Persons, Werkers, and Househoktis, Mars-Dade
4 Trends in Heussholf Size,

ia-Dads and Florida
5 (X) Trewwds in Popubetion 65 or lder, Miawi-Dacke and Florida

B 2] Trends in Mecien
3] Trends in Licensad Drivers by Gander, Wiami-Dade

12 (2] Trendhs in Vahicke Tags Sokt and Licarsed Drivers, M- Dude:
uﬂmm—m:mmvdﬁlqmmn

12 2] viiela Vagu per Livensad Driver, Miss-Darle and Foridy
15 (Z) Tramds in Haussholos lry Vehicle Owrarship, Mai-Dads
4 () Traimsht b Highwesny Gantariives Ml by Spttise, Misiri- Docke
15 () Donberiine Mbas of State Tell Faciites, M- Dade 1997
16 (5] Trumals in Misbrbus Reastes Mivs, M Dadir

12 () Trands in Metrorall Routs Miex, Musw-Dade:

18 20 Tranls In Makromeer Rowte Mint, Masd-Datle

193] Trandds In Ouly Pernon Triga by All Mo, Muri-Dade:
27 Tramds InDally Paricen Trips Par Capita by A Mades, M-
Dade

2172 trends in Annual Vehicie Mies Iroveled, Memi-Dade @ orida
% ) Tremks in Aversge Daly Trafic
A Salectisd Locations en 1-95, Mewi-Dede:
2] Trands n Average Dally Tratk
2t Subuctud Lecations on Dolphin Expvy, Muam-Dede:
2 ) Trends in Average Dally Traffc
# Sulected Lacations an Peimetto Expwy, Masi-Dade
23 Tranchs In Average Dally Traffc: 2t Selcied Lacations on ALK,

ﬁ!w

wea

This folder is designed to contain reports developed by MPO staff using the report-writing

functionalities provided by ArcView GIS, MS Access and/or by MS Excel.
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3.1.6 WebPages

This folder is designed to contain various types of web-enabled pages developed by the consultants

as well as by MPO staff. These pages fall into two categories:

3.1.6.1 HelpSystem

This folder contains help files used by the Access application (see Chapter 5). Files are in HTML

format, and are enabled by double-clicking on them.

3.1.6.2 ImageMapper Files

As part of this project, the MPO acquired HTML ImageMapper 8.1, an extension to ESRI’s ArcView
GIS 8.1. This extension enables the TDMS to create web-enabled maps for Internetand/or intranet

publication.

This folder is designated to hold sub-directories, each | gmyess - 53 ,» ' Y— %Q:an,

containing the results of applying this extension on data %% & Fi\Dstastoro\WebPagesumagetiapper Fles

being worked on within ArcView GIS. -y i

R R L. ) L3 u Bka Faths and Lanas
At the tme of this wrnting, various HTML B i Commission Districts
e 8 {7 DadePop
. . . B2 LI DOT Fatalty Crashes 1997-99
ImageMapper web pages were included in this folder, W L FataiCrashes
& {40 MDPoliceStations
. ey . . Ry TAZZO00-Adilne
as shown in Exhibit 3-21, at right. & £ Taz ~ 2000

3 i Matadsta Fies

It is noted that HTML ImageMapper creates an individual master folder for each page it creates. As
shown in Exhibit 3.22, below, this master folder (in this case Commission Districts) contains, in
standard sub-folders, all navigational (nav), zoom (map) and attribute query (att) functionality
required to make the page work as a separate, self-contained HTML entity. The user enables the

page by double-clicking the index.html file corresponding to that master folder.

Page 26



Qo -

?? ﬁ,} Search }&;: Foldaers ; '

fddress I{3 Fi\DataStore\WebPages| ImageMapper FhesiCommission Districts L S zﬁ .
& 7 Commission Districts et Eile Folder
Sy att Lhmap File Folder
# {2 map Lhnav File Foider
#® 3 nav @mmﬂ: 1KB  HTML Document
& 7 DadePop g Jimaptitie 1KB HTML Document
i i3 DOT Fatality Crashes 1997-99 index 1 KB HTML Document

A more extensive discussion on running an HTML ImageMapper map-creation session is presented
in section 4.x, the next chapter of this manual. Complete documentation on this extension is provided

under separate cover.

3.1.6.3  Metadata Files

This folder holds files describing the data contained in the multiple geodatabases and symbolized
layers created as part of the TDMS. This is called “metadata”. The ArcCatalog module of ArcView
GIS 8.1 allows the user to easily create and maintain metadata. It also provides the user with the
ability to extract this metadata into several file formats. One of these formats, suitable for web and

text description usage, is atml, suitable for web and regular viewing and publication.

As part of the TDMS creation process, the consultants and MPO technical staff extracted html
metadata files for each feature class included in the numerous geodatabases, as well as the
symbolized layers comprising the system. The Access application described in Chapter 5 makes

extensive use of these hrml files.
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3.2 ModelsAndApplications

This folder contains various transportation-oriented models and applications. It is essentially divided

in three sub-folders, as follows:

3.2.1 FDOTApPpsS

As of this writing, this folder contains input and output data for three (3) specific GIS-oriented
applications developed by and obtained from FDOT District 6. The names of the folders describe the

basic focus and contents of the individual applications:

3.2.1.1 HighAccidentSpots

As the name implies, this application takes 5-year data on accidents occurring on state roads and
maps it to FDOT’s dynamically-segmented Basemap. The resulting spatial theme is symbolized by

types/gravity of accident.

3.2.1.2 PavementManagementSystem (PMS)

This application takes multiple-year data on rated pavement conditions on state roads, and maps it to
FDOT's dynamically segmented Basemap. It also maps various other related themes, such as

Proposed 5-year Work Plan and Priorities.

3.2.1.3  RailroadHighwaylnventory (RHIS)

This application bring together FDOT’s Basemap with Miami-Dade County’s railroad line map, 1t
establishes a point file for intersections, and locates 4-way digital photos to each intersection. It also
maps data on accidents occurring at those intersections, by types/gravity of accidents.
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3.2.2 FSUTMS

This folder contains input data as well as symbolized layers and map products for various sets of

analysis drawn from the execution of the Florida Standard Urban Transportation Modeling Structure

(FSUTMS) model(s) by MPO technical staff:

3.2.2.1 NetworkNodesAnalysis

This folder focuses on the latest petwork-node data provided by the execution of the FSUTMS

model.

As shown in Exhibit 3.23
(at right), it includes the
FSUTMS geodatabase
containing 2025 data for
two feature classes:
Network and XYnodes, as
well as various symbolized
layers de-rived from those
feature classes, namely
direc-tional AtoB or BtoA,
volume-to-capacity ratios,
capacity and traffic

volumes.

Ut [HDHPDTONS Wi FSUTH et e

Qs 4| -
= B rums
2 hetwork
£ Yinodes
205 ¥ R
Dushanty 5| Vs e
@20259&&& h @MSAB‘JM Laver
Layer
Laer
Layer
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3222 TAZI999Analysis

This folder focuses on socio-economic data, such as housing, employment, automobile utilization,

income levels, etc., as applied to the 1992 Transportation Analysis Zones (TAZ) structure.

As shown in Exhibit 3.24, at
right, the folder contains the

TAZ1999Analysis geodatabase,

showing its  socio-economic
oriented feature classes, as well
as the supporting symbolized
layers created from these feature

classes.

3.2.23  TAZ2000Analysis

! Lddionr ;&wo«m-muswmppumwsumsﬁmssa;n;;; =

o

gmzwwmuws
Elrazige2

) TAZ1999-AdjustedincomeData Laryor
S TAZ1999-C arsliyHousing Type-ME_1 Car Layer
© 1421999-CarsByriousingType-F_2Cars Layer
€ TAZ1999-CarsByHouBNG Type-MFE _NCCars: Layer
€ TAZI099 - CarsByHousingType-SF_OCars Layer
) 1421999-Car sByHousingType-SF_1L Car Larer
© TAZ1999-CarslyHousngType-SF_2Cars. Layer
B 1A21999-CB0_ExUibarData Layer
© TAT1999-EmploymentData-TotalEmploymment Layer
€ TAZ1999-HoteMot alDat a-HotEIOCC Laver
@ TAZ1999-HoteMotelDat s HotelRas Layer
© TAZ1999-HoteMotolData-HokelR.oom Layer
€ TAZ1999-HoLmhokdDat a- Tok siHousshokls Layer
© TAZ1999-HousiagDats- TotalHousing Layer
) TAZ1999-OcoupdR oomsData-Occ_Rooms Layer
TAZ1599-CarsByMHousing Type- &> TAZ1999-Persorliata-P_Chidran Layer
TAZ1999-CorsByHousingType- | ‘@ TAZI999-PersonDiate-P_NoChild Layer
TAZL99-CorsByHousingType- € Taz1995-PopuiskionData- TotalPopulation Layer
TAZ1999-Car sByHOusgType- € TA21999-5choolErvolmentData-5ch_Envol Layer
TAZ1999-CarsByHOUSIType- € TAZ1995-VahicleData-v_Chidren Laysr
) TAZ1999-VehiceData-v_NoThid Layer
o ] € TAZ1999-WorkarData-w_Chédren Layer
PRSI R © TAZ1599-WorkerDataW_Nothid Layer

This folder focuses on socio-economic data, such as housing, employment, automobile utilization,

income levels, etc., as applied to the 2000 Transportation Analysis Zones (TAZ) structure. The
TAZ2000 network is the current standard used by MPO, and superceded the 1992TAZ network,

which now is being kept for archival/historical purposes.

As shown in Exhibit 3.25, at right, this folder contains the 1999-2000Data geodatabase, showing its

socio-economic oriented features;

well as the supporting symbolized layers

created from these feature classes.

as

“bowg . R TEHS Mocandbopb sior FU TG \TAZ 000 et

AT b

L

i

|

*.
*
-9

m

Abirtel Brom

#is

LineZ00008ta
3 19952000000
T empirymertoets
§flHousingPop
P TAZZ000-AdustedZromeData Y _AGH TS Lavm
1 € TATZ006-CorclyHousng Ty MF_1 Cae tayer
D TAZZO00-Con sByHousrg Tyne MF_2Cars Laver
| €9 TAZZ006-CarsbyHowsngTyne-MF_NoCars Layer
'} € TAZZ000-C o sByHOLSINg Type SF_1Cor Layes
P TAZZ00G-C enclyHoutng Tyne-5F _2Cars Layet
1 4 TAZ2000-C o sBy+ousing Tyne-SF_NoCars Lavoe
D TAZ200G-+HobalMot et d-HOLH SCx Layee
B TAZZ000-HotelMoteDat e-riotei_Res Laver
D TAZ2O00-HO: sl A _Ripints L
P TAZZ000-HosngOaks-Tok_Housn Loy
P TAZZ0N-Popuationlina-Pop:_Total Laver
3 TREZDIN-SchonkErvoimentData- Sch_Ervok Layer
& TALZ000- ScrookDat o-Bem_Enrol Lavor
> TAZZ000-SchoolsOut a-igh_Ernvol Layer
D TAZ2000- SchvocksData-Midd_Ervol Lavwr
B TAZZ000-Schookstvl s-Priv_Encol Lisyoe
Supetin
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This folder also contains two additional sub-folders, 2015Projections and 2025Projections.

Lcair: _ {ENAD PG TDHS Hodehindiors

ST TSRO T sk 7

Each of these sub-folders contain a IZressmrro T L e T Wantma}
| = il 2D1SProfetions e D e T
, I ; O ot o L
geodatabase with projections for the | 8] rmdincomaban B 142000 2015 Adtsdlocomabeta Inc A Lover
! B rcimins” 1D Urnetiebviemdiaid v
indicated year for each of its feature 2 oatmtatts S a0 1 Comenrmlive M. Lo
8 oo b Spcsimteimim ity
. : L _ ot Mo

classes; it also contains corresponding ! 8 resrcie & tazanscore o pomncwe e
Boit.. [Smmmmmeermeiese D

" ¢ -
symbolized layers. & oo ;Eilmimw““::& v

T

> el b S g
. ) TATZ000-2045P-CarsiHousingTyps 0:mm:sv+mmm _Housn x
Exhibit 3.26, at right, shows these fopiieoginiipmiriimrsdiialll B Scioopoinm e
: Az 201 b v igmneitesy W

. . TAZZ000-201 5P-CarsByHousing Tvpa |
components for the 2015Projections 3;mgfga°—m“°:;b. | ot sdekwderoma | Lave
‘ § TAZZ000-201 5P-HotelMotaData-Hotr | € TAZ2000-2015P-Schooktat a-+igh_Ervol Layer

- - . . i TAZ2000-201 oiMotellata-Hou

folder. Similar contents are included in | b P Lottt sl
TAZROOG- 20 - HoussholdateH_C: ::umm:wmv_mam Laver
. . * § @ Yazzo00 _Neorhid Layar
the 2025Projections folder. ettt b dincactiaminaisiv ol

3.2.3 ITMS (Integrated Transportation Management System)

This folder contains the executable files to enable the TDMS to launch the ITMS application. The
ITMS was completed prior to the development of the TDMS. It is noted that, to launch this
application, place the ITMS data CD in drive D: (the CD-ROM reader) of the MPO’s computer.

To launch the application from Explorer, double-click on the ITMS application icon. As shown in

Exhibit 3.27, at right, the main I[TMS menu

will appear on screen, then the user can

Integrated Transportation

MIAMI-DADE
choose the desired option. The MPO has all ' Management System (ITMS)
the mneeded documentation previously T _
prepared for the ITMS, j TMSH foo IHS
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4 TDMS PROCEDURES

The sections presented in this chapter address specific issues and procedures of relevance to the
creation, maintenance and updating of geodatabases and symbolized layers within the TDMS, to the
metadata process of this data, to the production of paper and/or web-enabled map products, and to

selected spatial analysis functions.

4.1 CREATING AND POPULATING GEODATABASES

The process of creating and populating geodatabases is performed entirely within the ArcCatalog

module, as follows.

Step | Action

1 | Create a new folder or subfolder to hoid the new geodatabase, or create it in an existing folder.
To create a new folder, select from menu File->New->Folder or, alternatively, right-click the
mouse on the folder above, select New->Folder. Type in the name of the new folder.

2 | Click on the folder where the geodatabase will be created, highlighting it.

Select from menu File->New->Personal Geodatabase or, alternatively, right-click the mouse,
select New->Personal Geodatabase.

3 | The system prompts the user to name the new geodatabase, as shown in Exhibit 4.1 below:

i - TransSys
= 28 Other
3] TI

r{fs TM_H

Personal Geodatabase

New Geodatabase under "TransSysiTraining ",
Name changed to "SampleGD"
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The user now wishes to populate this geodatabase, newly named SampleGD by creating
feature classes from existing ArcView 3.x shapefiles, Arc/Info coverages, CAD drawings
and/or database tabies.

4a

In the first example, the user will incorporate an ArcView shapefile existing in another folder,
named TentativeSYearWorkProgram.shp. The user highlights the shapefile, right-clicks the
mouse, then selects Export->Shapefile to Geodatabase.

4b

The Shapefile->Geodatabase dialogue box
is shown, giving the user various choices, as
shown in Exhibit 4.2, at right.

At this point, the user:

[. Provides the name of the target
geodatabase, or browses to find it;

2. Changes the name of the new feature
class, as desired. Unless specified
otherwise, the feature class will be given
the same name as the shapefile.

3. Clicks on the "Change Settings” button.
This and the following are important
steps, as they ensure the setting of the
proper coordinate system.

When presented with the “Output Settings” dialogue
box, press the “Change” button in the "Current Spatial
Reference” tab.

Then, in the “Coordinate System” tab, press the
“Select” button. (Exhibit 4.3)

In the next dialogue box, click on
“Projected Coordinate Systems”, press the
“Add” button. (Exhibit 4.4)

. JA Coordinate Syt

5 Goooraphic Coordinate Systems
2 Projectedd Coorcinake Syt

e [Shntial Tefarancas S ]
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4e | In the next dialogue box, click on “State
Plane”, press the “Add™ button (Exhibit
4.5).
4f | In the next dialogue box, click on "NAD
1983 (Feet)”, press the “Add” button.
(Exhibit 4.6)
4g | In the next dialogue box, click on “"NAD
1983 StatePlane Florida East FIPS 0901
(Feet).prj”, press the “Add” button.
(Exhibit 4.7) w0 173 Sootrn g 7S o o)
mo §9683 StatePlana Guam FIPS 5400 {Feet).prj
TENAD 1583 Rasoriare Howes 2 FIP3 5102 ooty e
- s .4
IHAD 198 Statelane Mlorda EattFIPS 090 Femtlorl
4h | The next dialogue box confirms the
actions requested, click on OK if agree, e Bt
on “Change Settings” if something did wsibng foe
not go according to plan. (Exhibit 4.9)
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4i | The next-to-final dialogue box confirms the
user’s selection, provides the option to proceed
(by pressing the "OK” button) or to go back (by
pressing the “Change” button). (Exhibit 4.9)

4j | Back to the “Shapefile to Geodatabase” box,
press OK to confirm all settings. (Exhibit 4.10)

4k | Final result, Exhibit 4.11!! Note:

e The SampleGD geodatabase g'.’-"i",f""g"l"*m_: R
has added a new feature class |[QQO@0/8 & 3B BEX SIS L L
“TentativeSYear ooakr: d\imm-mhswmw@ﬁ@\rmmmm B
WorkProgram2000™. EETWN

» The characteristics of this
feature class can now be
viewed on the panel at right, by
pressing the  “Contents”,
“Preview” or “Metadata” tabs.

This exibit shows the

Geography characteristics in
Preview.
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The same procedures apply when adding Arc/Info coverages and/or CAD drawing files as
feature classes to a geodatabase.

To add a table as a feature class to an existing geodatabase, follow these simple steps. In this
particular example, we will be working with a dBASE table named “PriorityMatrix2000”.

It is noted that, should you wish to export a table from Excel or any other database, you must
first export that table into dBase using the database program’s own export file conversion
capabilities.

Ga

Highlight the table to be exported, right click, then press Export->Table to Geodatabase.

6b

The following dialogue box, ‘‘Table
to Geodatabase” (Exhibit 4.11)
opens.

The user is asked to select (typing or mam : . R .
browing) the target geodatabase, then ' '
to confirm the desired name for the
Output Geodatabase table. Accepting
the default will yield the same name
as the original table.

Press OK to confirm and export.

6¢

Final result, Exhibit 4.12!! Note:
e The SampleGD geodatabase has

added a new feature class [4% $ 0¥ LRI REXK . “x g,
“PriorityMatrix2000". ke VRGNS Do e el

e The characteristics of this feature

class can now be viewed on the

panel at right, by pressing the : wun%w e
“Contents”, “Preview” or % 1T m MR A
‘ ” : ISIUTH DADE EXPY. 198!
“Metadata” tabs. : | SOUTH DA Y T

. . . - Bl L . R
This exibit shows the Table =8 I e i

characteristics (only one possible neiia B ..
in this case) in Preview tab. :
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4.2 MODIFYING ATTRIBUTE TABLES

This section will describe various procedures to edit, maintain and update the attributes of spatial
databases. We provide examples using two distinct approaches, either one of which can be applied

by the user, depending on the circumstances and preferences:
1. Using ArcView GIS 3.2 on shapefiles;

2. Using ArcView GIS 8.1 on feature classes within geodatabases.

It is noted that the second approach can be used with both geodatabases and shapefiles, whereas the
first approach can be used only with shapefiles. In general, the user may wish to use the first
approach while working with an existing shapefile prior to it being exported as a feature class within
a geodatabase. On the other hand, if the data is already configured as a feature class within an

existing geodatabase, the second approach will be applicable.

421 Modifying Attributes within an Existing Table

4.2.1.1 Using ArcView 3.2 on a Shapefile

The following steps outline a procedure to modify attributes in a given shapefile or table, using

ArcView 3.2,

Step | Action

[ | With the indicated shapefile made active within a view, click on the “"Open Theme Table”
icon. The table will open.

2 Use the "Select” tool a to isolate the feature to be modified.

3 | Making the table active, select from menu Table->Start Editing. The attribute table is now
ready to be edited, with the specific feature to be edited highlighted in yellow, as shown in
Exhibit 4.13, below.

Puge 37




Miami-Dude MPQ

Trunsportation Data Managemens Svstem — Training Manual

i

2001, SW 1Bz 8L =
Fiagia St Nw 7 Gt 410 Lanes
| Pl 443300000000 T, 1 SR 51/ Tumpke Nw 2 Ave 4105 Lanes
<] Polline | 11,31 400006006 0 NE € 5t NE 135t Hecontiruction
{ Peliine | %1.8330000000C |_14.6530000000 X o wids Pk Ave 4106 Lanet
Pk ©.,00000000000 | 1., 0218 | 1995/0 | Miami Garders D 1 wiest of NW 67 Ave Carcl City Canal | 4106 Lanes
ol 0.25800000000 1. 002 | 200770 | Aon Rd BS! Wiichigen Ave | Aissuriacing
Pk € EE400000000 | 6,70800000000 | 0012 | 2006/0 | Colling Ave 265 dkst  Plesibie Pavemeri He
PokiL 000000000000 |~ 4.75400000000! 0z13 | 1999/ | Red Fioad/NW 57 Ay W 49 St Nw 13851 Ao 6 Lanes
{ ok ine " 31.23700000000 | 33.24800000000 0213 | 2002/0 | Hisleah Expwy SR 626 : Nw 7 hve 1 dicB Lanes
i P T N 7 = e e T T e T e T i

et i

South Dise Hwy__ 15w 112 Ave Sw 152 5t Fecorsinction A0 - |

Using the “Edit” tool , change the value of a specific field on the selected feature. For instance, we will now
change the content of the field “Improvemen” from Resurfucing to Reconstruction. The result is shown in
Exhibit 4.14. below.

§.65300000000 | 7.60400000000 | 0213 | 189941 ; SW 107 Ave Flagier St Nw 7 5t 4 tadlh | anes 8
443600000000 | 5.52900000000 1 6218 | 2000/ | Miami Gardens D1 | SH 91/ Tumpike W 2 Ave 48 Lanes
11 31400000000 | 11.87900000000 | 0213 | 208440 | Biscayne Bivd NE 5 St NE 135t Rffconstnction
11.63500000000 | 1463300000000 1 0213 [ 2000/0 ; Okeachobes Rd | W 195t Pam Ave fio 6 Lanes
0.00600000000 | 1. 70600000000 1 0218 | 1935/0 | Miami Gardene D1 | West of NW 57 Ave CagiCityCanal 1o G Lanes
0.25600000000 | 1.54000000000) | 0012 | 2001/0 | Akon Rd 851 Michigan Ave  Jf Resuacing
. 66400000000 Colins Ave 265t 44 5t Flexible Pavermesnt Recon
. 0000G0ROGA00 Red FoadATw 57 Ad W 49§t Nw 1385t 410§ Lanes
31'237mmm Hisleah Eupuny SR 828 410 Lanes
dcE - A R = : e

5 | Selecting from menu Table->Stop Editing will save the changes.
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4.2.1.2 Using ArcView 8.1 on a Geodatabase

Within ArcView GIS 8.1, the process of editing and maintaining table attributes can be performed in
either ArcCatalog and/or ArcMap. The “Using ArcCatalog” and “Using ArcMap™ manuals describe

attribute editing functions in detail.

To change the value of a given attribute in ArcMap:

Step | Action

I | Right click on the layer, click on
“Open Attribute Table” submenu.

LR e e IR ] [ e W
DE R NOME ' S o

The attribute table opens up, as shown
in Exhibit 4-15, at right.

Navigate to the record to be edited,
then to the field to be edited. In this
case, the user wants to work with the

Atiribute Table

road segment "NW 103 St”, between L LocA, awe | rnow To

“NW 6 Ave” and “NE 6 Ave”, and R R A s

wants to change the current scheduled PR e o .
improvement “IMPROVEMEN" field lo g™ 2l B aful sion M sk | hocoa ibass
contents from “Reconstruction” to -Eehesl . j3e e g m,mmﬂm gl A
“Resurfacing”.

2 | To effect the change, RS ; & =
the wuser places the LOCAL_RAME FRAOM TO_ IMPBOVEMEN | &
cursor on the specified g:::%::::i% :xag;t ::: :?;f" : E:z:: ::—ﬁ—:zg :%-
field, simply types the [ [Biscamebhd ~ |NESSt |NE13St " 'RecoMfuction [t
new contents and BPRTURSL - RUNSRL AR :

presses “Enter”. The ?@’
results are shown in [
Exhibit 4-16, at right.

3 | To undo edits, retype the original text/value, or alternatively click the *Undo” button on the
toolbar.
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422

4.2.2.1

Adding a Field to an Attribute Table and Populate It

Using ArcView 3.2 on a Shapefile

The following steps outline a procedure, using ArcView 3.2, for the purpose of adding an attribute

field in a given shapefile or table, then populating said field based on a calculated formula.

Step | Action
| | With the attribute table open, select from the menu Table->Start Editing.

2 | Select from the menu Edit->Add a field.
ArcView 3.2 presents Exhibit 4.17a.

3 The user then specifies the name of the field (Miles}, the
type (Number), and size (Width = 16, 3 Decimal Places), as
shown in Exhibit 4.17b. The type can also be specified as a
character string or as a logical field.

4 | By clicking “OK” the user accepts these specifications, and the field is created. The user may
wish to move the new field to a more desirable position, as shown in Exhibit 4.18, immediately
following the “Begin_" and “End_" fields.

50 ——— [ 0103 [ 200270] Paimetic Eeew S 72 5t

0 0213 Z2004/0] Paimetto Exp S B BE

o o213 2007 201 Palmatto Esoy Sw 16 St |

¢ .5 1293/0] Coling Ave Lireon Rd

L] Do 2 2007 70] South Disie Hiws S 112 Love

¥ 02137 188870] 8 107 Ave Filagier St

W O21E 2000/0) iamt G ardens Or SR 91 /Tunpike

021 2004/0{ e Bhvd ME 5 St
O 0213 2000,/0) bes Rd 19 St .
0000000 T 1828 T 100l Miaimi G ardens G777 st of NEVE7 A0S o

5 | The user wishes to populate this field by calculating the difference, for each feature, between

their ending mile post (field “End_") and the beginning mile post (field “Begin_". The
*Calculate” button @ is used for this purpose. If the calculation is to be effected across the
entire database, do not select any records. However, selecting certain records will effect the
calculation only for the selected ones.
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6 | The “Field Calculator” window is presented (Exhibit 4.19),
where the user can formulate the precise way in which the
field (in this case “Miles”) is to be calculated (“End -
Begin 7).

7 | Pressing  "OK”  will

2.33400000000 ;  4.57300000000 2.245: Q3 | 2002/0 Paimetto Expy SW 72 5t

populate the field. Exhibit
4.20 shows the result of [ 640000003000} 835300000000 1,983 013 200443 Paimetto E xpy Sw 2%t
) 6 5200000000 | 643400000000 0.852 0213 | 200170 Fakmetto Expy Sw 1651 =
the calculation on the [ 800060000007 65700000000 0657 005 | 193970 Colins Ave Lincon Rd
on g1 s fi7. 39500000000 | 16.22300000000 4.234 0012 | 2001 76 South Dinie Hwy _ | GW 112 ve
Miles™ field. 6.56200000000 | 7 60400000000 0.947 0213 19990 5W 107 Ave Fiagler St
. " 443800000000 | 552300000000 051 70218 | 200040 Miami Gardens D | SR 91/ Tungice

Selecting menu  “Table- [ nauomn ] 7187300000000 0.565] 0213 200470 Biscame Bivd | NE 551

e 1133300000000 |_14,63300000000 Z654 10213 | 200040 Okceechobee Fid 1w 19 &t
>Stop Editing” saves the  ['sisouoniomos] 1 75600000000 1.75] 0218 | 1398/0] Miami G owcens Dr | Wast of Nww 57 Ave
Changes‘ E EEvnununono R R l 3 N N "mm.: :53

4.2.2.2 Using ArcView 8.1 on a Geodatabase

Similar steps are followed when using ArcView GIS 8.1 to perform these tasks on a shapefile,

feature class within a geodatabase or plain table.

Step | Action

1 | In ArcCatalog, right click on the shapefile or feature class to
be modified. Select “Properties”. The Properties dialogue
box opens, with a note at the bottom advising the user that,
to add a new field, simply move to an empty row, start
typing its intended name and data type characteristics.

In this case, the user types “Miles” for Field Name, then
selects “Double™ as the Data Type, with a Precision of 18
and a Scale of 11. These numerical parameters are the same
as the “Beg_" and “End_" fields. These specifications are
shown in Exhibit 4-21, at right.
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2 | After clicking “OK”, the new s
field is created at the right BEGIN.. _PH | LOCAL NAME | #
T 2334 2002/0 PakmettoExpy S\
end of the table. The user can [T~ “gq| 20040 Pametio Expy ®
then move it to the desired j}{j = 5%82] (2001/0 PaimettoEwpy SV
e in th bl =1 A8l :1988/0 Colling Ave
position 1n the table. i 56 200170 South Dbde Hiny 5
. - o 3 ey | i i - frem
In this case, the new field 4. 8% (1830 SwWilzAve IRk
ii M 2y _ 4438 +2000/0 - Miarni Gardens Dr ESF
“Miles” has been moved next .%f el T T S 17
right to the “End_" field. All || . -
& - ) Heum¢£111ﬂ b
values are 0, as shown in b T LR
Exhibit 4-22. Freview  |Table

3 | To populate the new field in a similar
manner as was done in ArcView 3.2, the
user takes the layer into ArcMap, once there
opens the attribute table (by right-clicking on
the layer), then highlights the new field, and

chooses the “Calculate Values” option.

field (in this case “Miles™)
calculated (“End_ - Begin " ).

“query” file.

A dialogue box opens, which allows the user
to formulate the precise way in which the
1S to be

As shown in Exhibit 4-23, this approach is
closely similar to the one used in ArcView
3.2, except that this SQL-type selection,
once established, can be saved into a new
“query” file, and/or loaded from an existing

1 BEGIN:
“{END_
FD

| { FROM_
[ | IMPROVEMEN
LOCAL_MNAME
MILEAGE

' [ENG- BEG]

4 | After clicking the

o BE G

“OK” button, ArcMap
proceeds to calculate
the new values for the
field, Exhibit 4-24,
right.

WO

G

: g%‘?NEN;NE-‘EN'—“NéN Nt
&
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4.2.3

4.2.3.1

The fo

Deleting a Field from an Attribute Table

Using ArcView 3.2 on a Shapefile

llowing steps outline a procedure, using ArcView 3.2, for the purpose of deleting an attribute

field in a given shapefile or table.

Step | Action
1 With the attribute table open, select from the menu Table->Start Editing.
2 Click on the field to be deleted, in this case the same field “Miles”, as shown in Exhibit 4.25.
= co ymom— - O ..... i
‘ R e g —— I From__ :
1 2.33400000000 4.5739300000000 Paimetto Expy Sw 72 St
1 E. 40000000000 8. 38300000000 Palrmetto Expy Sw 2 St
5.58200000000 1 5. 43400000000 0.852 10213 1 2001 /0] Paimetto Expy S 18 Sk
1999/0| Cofling Ave Lincon Ad
200170 Scuith Dixee Hyey SW 112 Ave
19899/0! SW 107 Ave Flagier St
2000/0! Misami Gardens Dr SH 91/Turnpike
2004/0; Biscayne Bivd NE 5 St
2000/0 Okeechobes Rd w19 St
y 199970 Miami Gardens Dr West of NwW 57 Ave j
I sl B Rty HE TS Splao 3 G FRIE TR |
3 Select from menu Edit->Delete Field. The user is asked to confirm the deletion. After
confirming this action, the field is deleted, as shown in Exhibit 4.26.
_ o L . ;
o Local na G- From i
200270, Palmetto E spy SW 72 St SW 32 St
2004/0] Paimetto Expy Sw 2 St Nw/ 26 St
2001 /0| Paimetto E xpy Sw 16 St Sw 2 51
1399701 Colins Ave Lincon Fd 36 St
20010 South Diie Hwy Sw 172 Ave SW 152 St
1999,0] 8w 107 Ave Flagler St MW 7 5t
2000/00 Miami Gardens Dr SR 91/Twnpike Nw/ 2 Ave
2004701 Biscapre Blvd NE 5 St NE 13 5t
2000/0| Okeechobes Fd W19 6t Faim Ave
8,.11399/0 Miami Gardens Dr | West of Nw 57 Ave _....i.Ear0l City Canal
4 | Selecting menu “Table->Stop Editing” saves the changes.
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4.2.3.2 Using ArcView 8.1 on a Geodatabase

The following procedure shows how to delete a selected field within the table.

Step | Action
! | In ArcCatalog, select the desired shapefile or feature class within the geodatabase, then within
the Preview tab select “Table” view. The attribute table will show. Click on the field to be
deleted, FM_. This will highlight ail the underlying attribute values for that field, as shown in
Exhibit 4-27.
a2 ejo[# wamnex - ixlaasw e
* Localon: ‘_j:'.:'::;'i.C.::‘Q.d‘bNﬁj-TDMS.\D:aiiz;é_t;e\:baa\”Tr.&fSys\Tr&iﬁ@&s@b.mﬂ# """" diveSY v
-itnue
2 | Right-click on the field’s header, select Delefe. ArcCatalog will advise you that once a field is
deleted, the action cannot be retrieved. Proceed at will..
3 | The field is deleted.
4 | Proceed similarly with any other fields wished for deletion.
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4.3 CREATING AND MANAGING METADATA

The process of editing and maintaining metadata is also performed entirely within ArcCatalog. As
indicated in Chapter 2, the software provides an extensive set of tools to perform these tasks. Before
tackling an actual metadata management session, the following paragraphs will describe the basic

components and options provided by ArcCatalog’s Metadata management screen.

When pressing the Metadata tab, three subsidiary tabs are presented, as shown in Exhibit 4-14

below:
1. Description 2 Spatial 3. Antributes

It also provides a set of tools to manage the contents of these three tabs and of the entire Metadata

environment, exhibit 4-28.

| Ple Et Wew Go Inos Help

laa @0 ®lie B> e as o
ELisdotion: - *|CYMD MPD-TDMS\D, BRD ata\ TransSye Ty Metadata ;
A &% w LA Management Tools

Keywards
Theme: it oims wid Fid s jobi g iy i e
TEREE:

Description
Abstract
R T St R T S N o O BT TSRS I A i34
Purpnse
Coomtptagrrient e 00 PR p lest T o Powtioe b Pri cratad et wareew B laetgseitizzies B b Taie b

Status of the data

Titme parigd for which the data is relevant

PFublication Information

Data starage and access intormation

:@
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As the name implies, the Description tab contains information specifically describing the feature
class, including: keywords; an abstract short description; purpose; status of the data; time period for
which the data is relevant; publication information; data storage and access information, and several
other important fields. Some of these fields are required, others are optional. ArcCatalog provides a

“skeleton”, allowing the user to complete as many or as few of the fields as wished.

The five Metadata management buttons circled above perform the following functions, from left to

right:
| & (2 4 3
Edit metadata for the Dispiays metadata Automatically create or  Import meladata of  Export meladata of the
selected item properties for the update metadata for the the selected itern selected item
selected item selected item
4.3.1 Editing Metadata

By clicking on the leftmost icon, ArcCatalog provides a series of tabbed screens, which allow the
user to fill in a vast number of fields and/or to edit existing information in these fields. It is outside
of the scope of this manual to cover these tab screens in detail. MPO staff is encouraged to review in
detail the full range of metadata documentation available through these screens. We will cover those

screens deemed relevant to this report.

Exhibit 4-29 shows a typical metadata editing dialogue box, with multiple forward and backward
tabs. The tabs to the back indicate the major item. The tabs in the front provide variouns input/editing
choices within that first tab. The box, as shown, is ready to take inputs from the user into the
“Identification->General” screen. At this point, the user can enter text for “Abstract”, “Purpose”,
“Language”, “Supplemental Information”, “Access Constraints”, “User Constraints”, and “Data Set

Credits”. Although some of these required fields, the user can just leave in the default text.
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Additional metadata types can be
entered and/or edited by tabbing
on the various other selections
available. In addition to

“Identification”, other major

items include “Data Quality”,
“Data  Organization”, Spatial
Reference”, “Entity Attribute”,
“Metadata

“Distribution” and

Reference”.
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It’s worthwhile noting that some of
the work done during the process of
creating, from a shapefile, a feature
class within the geodatabase, as
explained in 4.1, has resulted in the
automatic updating of the spatial
coordinate metadata, Exhibit 4-30,
left, shows the complete set of
coordinate information provided by

the Spatial Reference tab.
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Exhibit 4-31, at right,
presents the screen when

pressing the “Entity

Attributes” primary tab,

then the “Attributes™

secondary tab. At this

point, the user can review

and delete, if desired,

metadata reference to

selected attributes. In this

case, the attnbute

“FROM 7, previously deleted from the attribute table, can now be also deleted from the metadata by

pressing the Delete (X) button.

432 Exporting Metadata

As indicated above, the metadata functions of ArcCatalog provide the ability to export the metadata
created for a given feature class. We used this functionality extensively to obtain self-documenting

HTML files viewable through the MS Access application described in chapter 5.

The process is initiated by pressing the Metadata Export 3 button, then filling in the
information requested in the following dialogue box (Exhibit 4-32).
: Note first that the location parameter requires

the user to indicate the full path where the file 1s

to be placed. Second, the selected choice under
Format should be “"HTML”. After pressing the
“OK” button, the new HTML file can be

accessed and linked to in the indicated location.
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4.4 DISPLAYING, QUERYING AND MANIPULATING MAP DATA

Actions to display, query, symbolize, prepare a layout and/or otherwise manipulate spatial data in
map form are performed in the ArcMap module of ArcView 8.1. This section of the manual
highlights several commonly-used ArcMap procedures. A more in-depth presentation of the full

range of ArcMap’s built-in capabilities are presented in the manuals listed in Chapter 1.

4.4.1 Displaying Map Data

The following procedure shows how to add and symbolize data within an ArcMap session.

Step | Action

I | Bring up ArcMap, either PFECFEEI0 p—
as a direct program call @@ O @ © 28| o

from the desktop, or by f Ls;,u;m
{1 PricrikyMatrixzo0g

clicking on the ArcMap g DIV emwekrogeamizooo
button  within  Arc

Catalog, as shown in
Exhibit 4-33, below.

CE Y

2 | ArcMap comes up.

The user can start populating the
dataframe by clicking and dragging one
or more spatial databases, in this case
“Tentative5YearWorkProgram2(000”
feature class from the SampleGD
geodatabase, into the ArcMap display
space (Exhibit 4-34). Additional layers
databases can be displayed in the same
dataframe, by dragging them from
ArcCatalog or by pressing the Add
Data button within ArcMap.

Dﬁnawrwy I
WO#*R‘kOHu! Ly

Hk Am

-' 2
g [Soeo] T a0 2y A _ | ]
Drawng v K D' A':Z(f;?]ﬁlﬂ __]jm =l »

[ izege wmeerse |
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3 | To change the way the data is represented, the user would right-click on the theme to be re-
symbolized, chose “Properties”, then click on the " Symbology” tab.

4., | To choose a single
symbol, the user clicks on
“Features->Single

Symbo!”, then on the
button. A dialogue box
opens, allowing the user
to choose the color, width
and type of symbol
desired. In this case, a
thick red continuous line,
as shown in Exhibit 4-35,
at right.

shown in Exhibit 4-36, at right.

6 | There will be occasions when the user may wish
to present thematic symbology based on the
values of certain parameters within the database,
in this case, for instance, the value of the
“Improvemen” field. The user would then
rightclick on the theme, choose “Properties-
>Symbology->Categories->Unique Values™,
then choose “IMPROVEMEN" as the Value
Field, as shown in Exhibit 4-37, at right..
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7 | Clicking on the "OK” button bring the desired
changes, as shown in Exhibit 4-38.

layers”. This layers can be reused at any time for any other map. In fact, numerous symbology
layers, each focusing on the vlaues of a specific attribute field, can be created and saved from a
single feature class.

To save a given classification into a permanent “symbology layer”, right click the theme, then
choose “Save as a Layer File”. ArcCatalog will provide the user with a dialogue box to indicate
where the new layer file is to be saved. After the layer is saved, it can be repeatedly used as if it
were a stand-alone spatial database.

9 | ArcView 8.1 also allows the user to import “legend files” created in ArcView 3.2. This is useful
when the user wishes to preserve, in an ArcView 8.1 layer, the same thematic classification
developed for a prior
ArcView 3.2 project.

The following steps
describe the process,
starting with an existing
thematic classification in |
ArcView 3.2, as indicated ~
in Exhibit 4-39, right.
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Oa

Double-click on the shapefile’s theme legend. The Legend Editor Dialogue box appears. Click
on the “Save” button. Save the legend file (with an .avl ending) to the desired place in the hard
drive, as shown in Exhibit 4-40, below.
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Once saved, this .avl file can be used to replicate the same symbology in ArcView 8.1. It is
noted that this .avl file can be used not only with the original shapefile but also with a similarly
structured geodatabase feature ¢lass. To execute this approach (Exhibit 4-41) in ArcMap;

a. Right-click the layer to be symbolized.
Choose Properties->Symbology.
Click the Import button.

The “Import Symbology” box opens.

o o6 o

Choose the “Import symbology definitions
from an ArcView 3 legend file (*.avl)”
radio button.

f. Specify what you want to import. You have
several choices, including:
e Complete symbology definitions
e Just the symbols
o Just the classification

The first choice ususally works best.

g. Type in or browse to the location and name
of the desired “*.avl” file.

h. Indicate the value field on which to import the symbology. In this case, “IMPROVEM”.
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i. Click "OK”, then "OK”

9¢ | The original symbology now controls
the display of the new ArcView 8.1
layer. (Exhibit 4-42, at right).

This new symbology can be now saved
into a new layer, as described in Step
8, above.
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4.4.2

Selecting Data Through Spatial and/or Attribute Queries

ArcMap provides the user with the ability to select features based on spatial and/or attribute queries.

Step | Action

] The selection process starts by clicking on the

Selection menu, as shown in Exhibit

o Select by Attributes

e Select by Location

query.

provides a number of options, including:

Each of these can be used as a single query, or can
be combined to provide a complex spatial/attribute

4-43, This

select all road segments scheduled for

2 | The user, wishing to select by attributes, clicks on the first option. ArcMap comes up with a
dialogue box where the user can specify the desired selection. For instance, the user wants to
“Reconstruction™.
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To set up this SQL-style query (see Exhibit 4-44), the
user double-clicks on the desired field on the left panel,
"IMPROVEMEN", double-clicks on the “=" sign
(middle panel), then completes the process by double-
clicking on the desired value, “"Reconstruction” (right
panel).

The results of the query are reflected in the lower
window.

The user can set up complex queries, involving “and”,

’ SELECT * FROM TortativeBY emWoakProgramZ000 WHERE:
’, “like” and “not” operators, as well as a number of | [IMFROVEMEN] = Reconstctort \

!5 g, Y LI TY LA Y

numberlc operators, such as “=", “>7, <7, u=T) S,

Resulting
auery

It is also noted that the user can save queries, using the
“Save” button, as well as load previously created

queries, using the “Load” button. This is a significant | oces | vew | J
B & |

improvement over Arcview 3.2, which did not provide
this important time-saving functionality.

3 | By clicking on the “ApPPIY” [ c e o soocm 1ot som ew
button, ArcMap executes |2Z5® f. e Slge we

_ : 01- IR OME T E
the query, which now

reflects on the display h

window, as well as on the

corresponding attribute B ;,:?it';"
table. Hota™

As shown in Exhibit 4-45, F
selected features are shown
in a light blue “selection” [ s »

e

g
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4 | It is noted that this is the default selection color, the user
can choose other colors from the “Options” submenu
within the “Sefections”™ menu, as shown in Exhibit 4.46.

5 | The user can further expand or narrow the

a.

selection by clicking on the extensive
“Select by Location™ submenu. This opens
up another dialogue box (Exhibit 4-47),
enabling the user to select features which:

Are within the boundaries of a set
graphic;

Spatially relate to features in the same
or other layer, including:

¢ Intersect
¢ Are within a distance of

e (Completely contain or are
completely within

e Share the line segment with, or
share the boundary of

¢ Are identical to
* Are crossed by
e Have their center in

the indicated “relational” layer.

Cnin

Yellow
Selection

r

Selection
specification.

Spatial relationship
specification ZI i
T Relational

Bufferil
specification

ng

Exercising the extensive spatial selection options is beyond the scope of this manual. Users
interested in exploring these capabilities are encouraged to read the corresponding chapter int he
“Using ArcMap” manual.
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4.4.3 Using a Map Template

As indicated in Chapter 3, a number of map templates were developed and stored as an integral part

of the TDMS. The user may choose an existing map template to start his’her map publishing work,

then add the desired layers, thus

1. Saving significant valuable time.
2. Maintaining approved standards. 10017 Cratm Lo Vo

To start the process, the user chooses
an existing map template from those
available in ArcCatalog, as shown in

Exhibit 4-48, at right, simply by

clicking on the desired template.

..A-..J.. u. l. »IJ“?.n T L |”[n.a LI tn¢ 4o _‘J
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Bo Tk Yen o look bep

i amind
11x37 Corty rbanteed kres- Ry
11X17 Courdy Urbanized Arex
11517 Quaviared Landszape View-

This brings up ArcMap, loaded already with the selected template.
Exhibit 4-49 shows ArcMap pre-loaded with the *11x17 County
Urbanized Area — Style 2 ” template.

The user continues by adding layers, selecting features, modifying
attributes, etc. At times, one or more of the layers pre-loaded with
the given template may have to be deleted. The user may also wish
to zoom in the detaill map to the level desired; it is noted that this
template 1s built so that the “county-wide” reference map shows, at
any zoom level, the area selected under the detail map. As soon as
possible thereafter, the user should save his/her new map under a
new name, and not as a template, but as a new map (*.mxd) file, to
be stored in the Maps subfolder within the DataStore main folder

of the TDMS.
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444 Creating and Displaying a Chart

ArcMap provides the user with tools to create and display various types of 2- and 3-dimensional

charts, including frequency, pie and others.

| O B o Y i Sk s
Exhibit 4-50 shows the “E-Size County Urbanized 2.
Area with Graph” template. Note the included | -e%
column bar graph, representing the numeric values of ,:m:
a variable, in this case “Colleges”. The actual | :
contents themselves are unimportant. E_g:
g
What matters is that, by double-clicking on that chart
frame, we open up ArcView 8.1°s chart-definition
capabilities. o -

For instance, we may wish to change the chart type to represent a pie chart, rather than a column bar
graph. This is easily accomplished by changing the type in the selection area on the left of the box, as
shown in Exhibit 4-51, below.

Sroph wi Colle;
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When accepting the change indicated on the
second frame, and clicking “"OK”, the chart frame
changes to represent a pie chart, as shown at left,

Exhibit 4-52.

It is noted that the above captioned Properties
dialogue box contains all of the necessary
elements to develop an extensive series of
business-oriented charts and graphs. For
additional details, consult the “Using ArcMap”

manual.

It is also noted that both MS Access and MS Excel have excellent built-in charting capabilities. As

both of these programs (particularly Access having ready interaction with ArcView 8.1°s

geodatabase structures) are available to the user, these additional charting capabilities can be easily

incorporated into the TDMS?.

4.5 CREATING TABULAR REPORTS

ArcMap provides a full complement of capabilities to build tabular reports. The user can choose

from creating:

1. “Simple” reports, showing for a selected layer (or features within that layer) the values of certain

fields in a ready-made tabular form. While these reports can actually display data in *fancy”

ways, the approach is most effective when used to quickly create fairly straight forward,

uncomplicated reports.

2/ Section 3.x presents a short discussion on creating charts using Access.
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2. A fully-featured version of Crystal Reports is included within ArcView 8.1. Through a systems

of “wizards”, the user can configure and develop highly complex, visually attractive reports

which may include, in addition to the desired table, also complex business charts, logos and even

pictures of the actual map displays.

To initiate the process of configuring a report, click the “Tools->Reports” menu, then choose

between “Create Report” (“simple”) or “Crystal Reports Wizard” .

The following describes the steps taken to set up a “‘simple” report.

Step

Action

Click on the “Tools->Reports->Create Report” menu item. When the Report Specification
dialogue box comes up,

2 | On the Fields tab, click the Layer/Table dropdown arrow and click the layer or table you want to
base the report on.

3 | Inthe Available Fields list, double-click the fields to be included in the report.

4 | Check Use Selected Set if want to create a report with only the selected features.

5 | Click the arrow buttons to order the report fields.

6 | Click the Sorting tab.

7 | Click a field to sort in the Sort column.

8 | Check the Display tab.

9 | Click Settings and click Elements.

10 | Check Title to add a title to the report. Locate the Text property and type a title for the report.

Il | Click the Font property and set the font and size of the title.

12 | Click Show Settings to preview the report.

13 | Click Generate Report.

4 | Atthe top of the Report Viewer, click Add to add the report to the map layout, if so desired.
Click OK

I5 | The report is added to the layout as a graphic element. Each page of the report is added as a

separate graphic element on the layout. It is up to the user to determine how to place these
elements within the overall layout. By creating a report with a particular page size, the user can
ensure that it fits exactly where wanted on the layout.
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Further discussion on reports go beyond the intent of this Training Manual. It is noted, however, that
Crystal Reports, through its wizard structure is capable of producing highly professional reports,
which can then be independently saved and executed within the “Reports” subfolder, within the
“DataStore” folder of the TDMS. Furthermore, as was the case with Charts, both MS Access and

Excel have extensive additional report-making capabilities, which can be applied by the TDMS user.

4.6 CREATING WEB-ENABLED MAP PAGES WITH HTML ImageMapper

As indicated in Chapter 2, the MPO acquired the HTML ImageMapper 8.1 extension to ArcView
GIS. This extension provides for the design and implementation of semi-dynamic map pages for
display and manipulation in the web.

The following procedure describes a typical ImageMapper web-enabled map page creation session.

Step | Action

1 | In ArcMap, make sure you are in Data View. HTML ImageMapper only works in this view
mode, not in Layout View. :

2 | Make sure the HTML ImageMapper extension is loaded and ready. This is verified by the
program’s icon, a yellow hand, g on ArcMap’s button bar.

3 Should the icon be disabled or not present, click on “Tools->Extension”, check the HTLM
ImageMapper box.

4 | Zoom to the desired extent of the map web page. Click on the hand icon.

5 | The HTML ImageMapper control panel appears, as
shown in Exhibit 4-53, right.

You can further adjust the extent of the map page by
using the zoom in/out, pan and full extent tools. After
deterr>*=ing this extent, then click on the “Proceed”
icon "?""ll
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6 | This opens up the full ImageMapper dialogue
box, where the user, through its various tabs,
can specify exactly how the web page is to be
structured, zoom levels, queriable attributes,
atc.

Exhibit 4-54, at right, shows the user
specifying a zoom level 800%. The extension
allows zoom levels of 100%, 200%, 400% and
800%. It is noted that selecting a higher zoom | |’
level causes the resulting HTML code to grow | |
significantly.

; mﬁapmi Misp Lagout | HTHL Layout] Settings | Ouput |

ij » M I . mm p,,m, i w E

7 | The other tabs within the dialogue box allows various other page components to be fully
specified. When ready, clicking on the “Preview™ button provides a quick view of what the
resulting page will look like.

Clicking on the “Create Map”™ button starts actually producing the web page. When the process
is completed, ImageMapper invites the user to view the resulting page.

A complete manual of the software is provided under separate cover.
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5.0 MPO_TDMS ACCESS APPLICATION

The consultants developed an application, using MS Access, to provide additional documentation
and guidance to the TDMS user. Through a simple and clear GUI (Graphical User Interface), the
application provides the user with a detailed description of each of the system file components

previously described in Chapter 3.

To load and execute this application, the user double-clicks on the icon provided. After loading, the
following main menu screen (Exhibit 5.1) will appear, enabling the user to choose one of the three

indicated options:
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5.1 Data Store Menu

By selecting either the first icon to the left, or the “Data Store™ button bar, the user is directed to the
Data Store menu screen, shown as Exhibit 5.2. Once there, the user, by selecting an icon or a button

bar, is provided additional options, including the ability to return to the Main Menu and/or request

help.
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5.1.1 Individual Action Buttons (Data Tables, Symbolized Lavers,

Maps, Web Enabled Pages, Charts, Reports and Presentations)

The following description applies to all

individual action buttons, except for the

“Maps™ button, which has an additional .
Combo box

. U FRRPOTOME atasim G PIDES Dot
buttons, the user with presented with a | || sbisanven FOESTomariooms

option, as explained below.

After selecting any of the secondary

screen which follows a similar layout

across all options.

Report Button

I | l

presented after the user selects the Data || = T Metacala Button

Exhibit 5.3, at right, shows the screen

Tables icon or button bar. By clicking on

Rocord: W SH T » n ek O

the combo box, the TDMS user can
select a particular table and verify its path, the geodatabase it belongs to, and review the contents of

its metadata file.

For instance, the user wishes to find out more about the “Commission Districts™ table. The user then

can select that table (Exhibit 5.4),

Fewe mm"m -:|cqmmis;ipn = : et Gt S ;[

Path - [cAMD-MPO-TDMS \DataStore\DatavPIDE S insttuional

 GieoDatabase Name [FIDESWnsttutionalinstiutionsl

and be informed that its path is: “C:\MD-MPO-TDMS\DataStore\Data\PIDES\Institutional” and that

it is part of the “Institutionai” geodatabase in “PIDES\Institutional”.
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Additional information on that table can be obtained by pressing the “Metadata™ button to the right
of the screen. The following Exhibit 5.5 will appear. It is noted that some of the tables may not have

associated metadata, in which case pressing the button will result in no further action.

CommissionDistricts

Personal GeoDatabase Feature Class

Desiription

Keywords
Theme: Cammission Distritcs

Description
Abstract

Incorporated into PIDES->Institutional Geodatabase as a polygon feature representing the 1992 Commission districts. Boundaries
are changed whenever the commission district boundaries changes via the Redistricting Application,

Purpose
To create maps of Miami~Dade County Commission Districts.

Supplementary Infarmation
Created by ITD
Revisions
Date: November 2000 By: B, Khan, ITD

Status of the data
Time period for which the datais relevant

Pubiication Infermation

The user can click on the various tabs (Description, Spatial, Attributes) to obtain relevant

information under each of these tabs:
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By selecting the “Reports
Button”, the user can request
an on-screen report on all
available data tables, organized
alphabetically as shown in

Exhibit 5.5.

To obtain a hard copy of this
report, the user can send it to

the printer.

Data Tables

Feature Class Neane Puth GeoDatabose Name
Airpart Faclifies CWD-MPO-TDMSDataStore'D  TransSysiTW_OMTM_OM
Annual Average Daiy Tratic (AR, C:WD-MPO.TDMSDaeStone'D  TransSys\TM_HITM_H

AMutos Empioyment and Ecanaml  c:WMD-MPO-TOMSOateStoréD  PIDE S\SacicEconomicE cd cEc
Bike Lanes C: WD -MPO-TDMS DataStore'D  TransSys\TINT

Bike Palhs CMO-MPO-TDMSDaaStoD  TranaSya\TINTE

Bike Ways CWO-MPO-TDMS DataSloreD  TransSysiTIdl

Bus Mairienance Feciiies C:WD-MPO-TDMSDasStoreD  TransSys\TM_PTATM_PT

Bus Routes C:WD P O-TDMS DetaStore D  TransSystTM_PTATM_PT

Bus Roues wih Bike Racks C WD WP O-TDMS D ataStors'D

Bus Siops CMO WP O-TOM S D alaStore'D
Callle TY Service ireas WD -MPO-TDMSDatdStar e
Carals C:MD MP O-TOM SDalaStoralD
Cersus Block C:MDMPO-TDMSDatatoreD

Cersue Block From Stred Netw ¢ MD-MPO-TDMS\OataStoreD

TransSysiTITL
TransSys\TM_PT\TM_PT

PIDE S\DevelogmentafDevelopm
PIDESWhysicaPhysice
PIDESSaciECoNonKBooicES
PIDESSosiEconomic S atoEc

In the case of the “Maps” selection, an

additional option is presented, giving the

Mgt
R user the ability to execute an HTML

ImageMapper file, if available, as shown
in Exhibit 5.6.

Hap Name ICumumun e

Upon selecting this option, the user is then

presented with the corresponding map,, as

HTML
fmageMapper
View Button

shown in Exhibit 5.7, below. The user can

then zoom the map to one of the available

scales, navigate to a desired area within the

map, and query its attributes.
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1 ,_ Miami-Bade County Metropolitan Planning Organization (MPQ)

» County Commission Districts

5.2 Models and Analysis

By selecting, in the Main Menu, either the second icon to the left, or the "Models and Analysis”

button bar, the user is directed to the "Models and Analysis” menu.

The icons and buttons shown in

Exhibit 5.8, at right, are to provide G olitan Pla g s . |

the user with additional
information as well as access to

each of these applications.
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5.3 Database Updating and Maintenance Requirements

Maintaining the database underlying this application up to date is essential in order to maintain the
system fresh and valid, thus avoiding a gradual deterioration in the quality of the data and in the
overall usability of the application. We strongly recommended that MPO staff in charge of updating
the validity and freshness of the system’s data ensure that the strict data input and maintenance

standards are rigorously followed over time.
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Appendix A
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A.1 System Procedures
Process Step | Action
Start ArcCatalog
General 1 Click on PREVIEW Tab.
checking of 2 Click on the PREVIEW Puil-own Menu, select TABLE.
tables and 3 Delete unnecessary fields from geodatabase tables using Right-Click > Delete Field.
metadata 4 Click on METADATA Tab.
5 In the DESCRIPTION area, make note of incomplete or unfilled metadata description
6 In the ATTRIBUTES area, make NOTE of duplicate or old attributes
Start ArcCatalog
Editing 1 Click on the METADATA Tab.
meladata 2 Select the ATTRIBUTES area..
(deleting 3 Click on the EDIT METADATA icon.
unwanted 4 In the Editing dialogue box, select Entity Attribute on the menu..
attributes). 5 In the resulting dialog, click on the ATTRIBUTE Tab.
6 Use the navigation controls (next to Attribute 1 of nn) to select and delete unwanted attributes.
Start ArcCatalog
Exporting 1 Click on the EXPORT METADATA icon.
metadata (to 2 In the Export Metadata dialog, click on BROWSE.
HTML). 3 Select the target folder and name webpage, or select existing file to replace.
4 Click SAVE.
5 In the FORMAT pull-down menu, select HTML.
6 Click OK.
Start ArcCatalog. ..
1 Select the SHAPEFILE
FSUTMS - 2 Right-click > select EXPORT > click SHAPEFILE TO GEODATABASE.
Adding a 3 In dialogue box: click QUTPUT GEODATABASE and select target geodatabase.
Shapefile to a 4 In same dialogue box, rename FEATURE CLASS.
Geo- 5 In same diaiogue box, click CHANGE > CHANGE SETTINGS > SELECT
database 6 Select the PROJECTED COORDINATE SYSTEM foider > STATE PLANE > NAD 1983 (FEET) folder;
7 Select NAD 1983 FLORIDA EAST FIPS 0901 (FEET).PRJ and click ADD.
8 Click OK > OK 1o exit boxes and run procedure.
1 Start a new ArcView 3.x project.
FSUTMS - 2 Add in the main/master shapefile and subject DBF.
Creating a 3 Select subject DBF and select TABLE menu > PROPERTIES.
Shapefite (in 4 Deselect unwanted fields and click OK.
ArcView GIS 5 Move common field to beginning of fields in table.
32 8 Repeat 3 and 4 for main/master shapefile.
- 7
8
9
10
1
12

With both tables open select common field {first subject then master).
Click cn the JOIN icon at top.

Select VIEW window (which contains master shapefile).

Click THEME > CONVERT TO SHAPEFILE.

In dialogue box select folder and name shapefile.

Click YES to view shapefile in the VIEW window.
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Open dataset in Excel

FSUTMS - 2 Delete original column headings and leave new ones copied from previous year. - >>>DO NOT SAVE
Converting FILE
Excel 3 Select RANGE with all info within.
Datasets 1o 4 | Click FILE > SAVE AS.
DBF 5 Seiect DBF4 (dBase V) in the SAVE AS TYPE pulldown menu,
6 Rename file to shorter filename as done in previous years.
7 Click SAVE, and click on NO to "Format note dialogue box".
8 Click CANCEL when SAVE AS dialogue box reappears.
9 Close Excel file but *DO NOT SAVE".
i Start ArcCatalog..
5;?,?5? and 1 Enter (or Browse) for output folder and file, then click OK.
LEGEND file 2 Start ArcView 3.2 and create a new VIEW,
3 Click ADD THEME icon and locate desired fiie, then click OK
for Layers: 4 | Arrange the layer as needed (with desired number of categories, etc.)
5 Save LEGEND as a file.
, 6 Start ArcCatalog AND ArcMap
Creating 7 | In ArcCatalog, select the Feature Class. Drag and drop the ftem into ArcMap to create a new layer.
LAYERS: 8 | In ArcMap, right-click the Layer and select PROPERTIES.
9 In the Layer Properties dialogue select the SYMBOLOGY tab.
10 | Click on QUANTITIES > GRADUATED COLORS.
>>> On ocassion, it may be CATEGORIES
11 Select the VALUE drop-down fist and click on the desired field name.
12 After a range of categories appear, customize as necessary. Click OK.
i3 >>> |f a v3.x legend file was created, click IMPORT > IMPORT...ARCVIEW 3 LEGEND FILE.
14 >»> Click on the Browse button and locate the desired AVL file,
15 Once complete, right-click layer and select SAVE AS LAYER FILE.
16 Choose a folder and filename and click SAVE
i 1 Right-click on the desired feature class.
gi(gzgrf ed 2 Select the FIELD tab. _
SPATIAL 3 Click on SHAPE in the list of Field Names.
4 Below the list is the Properties List for SHAPE.
Reference 5 | Click on the BROWSE button next to Spatial Reference.
6 In the resulting dialog, click on SELECT.
7 In the dialogue titled "Browse for Coordinate System” double-click on the "Project Coordinate Systems"”
foider.
8 Go through the "State Plane" > "NAD 1983 (Feet)" foiders.
9 Select the file titled "NAD 1983 StatePlane Florida East FIPS 0901 (Feet).PRJ then click on ADD.
10§ Click APPLY and exit all dialogue boxes.
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A2. NOTES 2001.12.04

Procedure to edit Metadata:

1. Start ArcCatalog.

2. Using PREVIEW Tab, delete unnecessary fields from geodatabase tables using Right-

Click > Delete Field.

3. Using METADATA Tab, make NOTE of incomplete or unfilled metadata descriptions.
4. Using METADATA Tab, make NOTE of duplicate or old attributes.
5. If#4 is true, select EDIT METADATA > Entity Attribute > Attribute tab and delete

unwanted aitributes.

Data Source

Action

CabieTVServicesAreas 0OK; metadata exported

MobileHomeParks OK; metadata exported

Telecommunicaticns OK; metadata exported

Dumps OK; metadala exported
HurricaneEvacuationZones del dupl attr shape _area

HurricaneShelters del dupl attr adaaccess, psn_shel, psn_primar, sn
Wellfields OK; metadata exported

Colleges OK; metadala exported

CommissionDistricts

OK; metadata exported

CommunityCouncils

QK; meiadata exported

CountyBoudary del dupl attr shape_area; metadata exported
DCFAduitFactilies OK; metadata exported
DCFDayCareCenters OK; metadata exported
DCFracilities OK; metadata exported
DCFHeadStartProjects QK; meladata exported
DCFHealthDepartments OK; metadata exported
DCFNursingHomes OK; metatiata exported

DCFWomenlniChildCenter

OK; metadata exported

DCFWaomenInfChildVendors

OK; metadata exported

EmpowZoneCensus del dupl attr shape_area, shape_length, name

FireDepartmentGrid OK; metadata exported

FireStalicns OK; metadata exported

Hospitals OK; metadata exported

HouseDistricts del fields objectid; del dupl atir shape_area

Libraries OK; metadata exported

MajorNeighborhood OK; metadata exported

MDFire_RescueStation no metadata; del fields area, perimeter, pfiresro_, pfiresro_L; del ‘upl. attr
| ResponseOrder shape_area, shape_length
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MDFireBoardDistricts

no metadata; del fields area, perimeter, pfiredis_ pliredis_i; del dupl attr
shape_area, shape_length

MDFireRescueResponseServic

eArea

no metadata; del fields area, perimeter, pfireres_, pfireres_i; del dupl attr pfireres_i,
res_sta, shape_area, shape_length

MDFireStationSuppression...

no metadata; del fields area, perimeter, pfiresup_, pfiresup_i; del dupl attr
pliresup i, sup_sta, shape_area, shape_length

MDParks

no metadata; del fields area, perimeter, pparks_; del dupl. attr pparks_id,
shape_area, shape_length

MDPolicePatrolAreas

no mefadata;

MDPolicePrecincts

no metadata; del fields area, perimeter, pprecinc_, pprecinc_i; del dupi attr hou,
cong, shape length, shape_area

MDSolidWasteManagementGar

no metadata; del fields area, perimeter; del dupl attr th, tot, shape_length,

bagePick shape_area

MDWASAServiceAreas no metadata; del fields area, perimeter, pwasdsa_, pwasdsa_id; del dupl atir pilot,
omitted, shape_length, shape area

MunicipalBoundaries OK; del fields area, perimeter, pmunicwt_; del dupl attr munic_code,shape_length,

MunicipalFireStations

no metadata; del fields area, perimeter, lfiremun_; del dup! attr zip, munic_code, type

MunicipalPoliceStations

no metadata; del fields area, perimeter, Ipolimun_; del dupl attr fax, juris, sub_sta

ParkDistrict

OK; de! fields objectid; de! dupl attr shape_area

Parks CK
PoliceGrids OK
PoliceStations OK
Polls OK
PrivateSchools OK; del fields area, perimeter; del dupl atir x_ccord, y_coorg
Schools 0K
SectionBoundaries OK; del fields objectid, shape_leng; del dupl atir shape_area
SenateDistricts OK; del fields obijectid, shape_leng; del dupl atir shape_area
TeamMetroBoundaries QK; del fields objectid, shape_leng; del dupl attr shape_area
TeamMetroOffices OK

TeamMetroRegionalOffices

discrepancy: tmetro_ or limetro_id numbers?; no metadata; del fields area,
perimeter; del dupt attr ofcname, zip

USHouseOfRepresentatives

OK; del fields area, perimeter, pushouse_; del dupl attr cong, shape_lengih,

shape_area
BikeLanes CK
BikePaths OK; del dup! attr shape_length
BikeWays unknown fields: elevation, thickness?
BusRouteswithBikeRacks unknown fields: [at, lon?
DadeRoads no metadata; unknown fields: |_zip, r_zip, fig1, flg2, mun, grid, trss, cens, waste?
FDOTBaseMap cannot delete fieids road_ (s/a objectid), read_id (s/a rcadway)
FLIntraStateHighwaySystem no metadata; del fields road_; del dupl attr shape_length
FloridaintraStateHighway no metadata; del fields road_; del dupl atir shape_length; copy of
System "FLIntraStateHighway System™?
FloridaStateRoads unknown fields
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FunctionalClassifications no metadata

Highways OK

intermodalFacilities_points OK

IntermodalFacilities_poly OK

LocalStreetNames 0K

MajorRoads unknown fields: | zip, r_zip, fig1, flg2, mun, grid, trss, cens, waste?
StateRoads OK

StreetNetwark no metadata; unknown fields: fig1, flg2?

TrafticSignalsFDOT CK

TrafficSignalsMDITD OK

TrafficSignalsMDPW CK

AADT OK

FDOT Districts QK; del dupl attr shape_area

FedAidHwySystem OK

MaxSpeed OK; del fields objectid, shape_leng; del dupl attr shape_length

RoadImpactFeeDistricts

OK: del fields area, perimeter, prdimpct_, prdimpet_i; del dupl attr prdimpet_i,
rif_distri, shape_length, shape_area

SRCapacity

OK

SRFunctional Classifications

OK; del dup! atir rd_status, highmeasur, county, section

SRWPSectionimprovement

OK; del fieids id; del dupl atlr shape_length

SRWPStructuralimprovement

OK {mispelled feature class name?)

TrafficAnalysisDistricts

OK; del dupl attr shape_area

TrafficAnalysisZones1992

OK; del dupl atir shape_area

TrafficAnalysisZongs2000

OK; del fields rev2ktz_; del dupl attr acres, shape_leng, shape_length, shape_area

TrafficCountStations OK

AirFacilties OK; del dupl attr tower_type
SpecialTranspertationServices | OK

BusMaintenanceFacilities no metadata

BusRoutes 0K

BusStops unknown fields: x_coord, y_coord; del dupl attr y_coord
MetroMaover QK; del dopl attr shape_length

MetroMoverBoarding no metadata

MetroMaverMaintenance no meladata

Facilities

MetroMoverStations

discrepancy: Immovrst_ and Immovrst_i; unknown fields: x_coord, ycoord; del fields
area, perimeter; del dupl altr code, name

MetroRail

Discrepancy: amrail_ and amrail_id; unknown fieids: length

MetroRailMaintenanceFacilities

no metadata

MetroRailStations

OK

Railroads discrepancy: arail_ and arail_id; del fields Ipoly, rpoly, length; del dupl attr arail_,
arail_id, shape_length
Tri-rail

OK; del dupl attr rpoly, fength, atrirail_, atrirail_i, route, type . shape_length
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A3. Feature Class Metadata Export to HTML

g Meta- | Meta-
@ | data | data Del Duplicate Deleted Dis- Unknown
Feature Class Name Added| Export? Attributes Fields |crepancies| Fields Remarks
PIDES / DEVELOPMENTAL
CableTVServicesAreas OK| YES | VYES Completed
{McbileHomeParks OK| YES | YES Completed
Telecommunications OK| YES | YES Completed
PIDES / ENVIRONMENTAL
Dumps OK| YES | YES Completed
HurricaneEvacuationZones OK| YES | YES |shape_area Completed
adaaccess,
HurricaneShelters OK| YES | YES |psn_shel, Completed
psn_primar, sn
Wellfiekds CK| YES | YES Completed
PIDES / INSTITUTIONAL
Colleges OK| YES | YES Completed
CommissionDistricts OK| YES | YES Completed
CommunityCouncils OK| YES | YES Completed
CountyBoudary YES [shape_area Completed
DCFAdultFactiies OK| YES | YES Completed
DCFDayCareCenters OK| YES | YES Completed
DCFFacilities OK| YES | YES Completed
OCFHeadStartProjects OK| YES [ YES Completed
DCFHeaithDepartments OK| YES | YES Completed
DCFNussingHomes OK| YES | YES- Completed
DCFWomeninfChildCenters OK| YES | YES Completed
DCFWomeniniChildVendors OK| YES | YES Completed
shape_area, area
EmpowZoneCensus OK| YES | YES |shape_length, perirrlualer Compieted
name
FireDepartmentGrid OK| YES | YES Completed
FireStations OK| YES | YES Completed
Hospitals OK| YES | YES Completed
HouseDistricts OK| YES | YES |[shape area objectid Completed
Liprasies OK{ YES | YES

Completed
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IMajorNeighborhood OK| YES | YES Completed
area,
. . shape area, erimeter,
MDOFire RescueStationResponseOrder YES | YES shage:Iength gfiresro_, Completed
pfiresro_i
area,
. - shape_area, perimeter,
MDFireBoardDistricts YES | YES shape,_length ofiredis._ Completed
pfiredis_i
plireres i, res_sta, a:;ﬁﬁeter
MDFireRescueResponseServiceArea YES | YES ishape_area, gfireresl Completed
shape_length pfireres:i
, . area,
pliresup_i, sup_sta, erimeter
MDFireStationSuppression... YES | YES [shape area, ;ﬁresupl Completed
shape_length pfiresupii
pparks_id, area, NO INFORMATION. NEED
MOParks NC NG  |shape_ares, perimeter, TO BE REQUESTED
shape Jength pparks_ FROM ITD
MDPeliceDistricts YES | YES Completed
MDPalicePatrolAreas YES | YES Completed
hou, cong, a:aeri?;leter Completed Name changed
MDPolicePrecincts YES | YES |shape_length, gprecincj from PolicePrecincts to
shape area opreci nc:i Polling Precincts
. . ‘ th, tot, NO INFORMATION. NEED
kMDSoHdWasteManagement(:arbageﬁc NO NO |shape length, a::%]eter T0 BE REGUESTED
shape_area P FROMITD
pilot, omitted, a;?;’] eter
MDWASAServiceAreas YES | YES [shape length, gwas dsa’ Completed
shape_area owa sdsa:i "
munic_code, area,
MunicipalBoundaries OK| YES | YES |shape length, perimeter, Completed
shape_area pmunicwt_
zip, munic_code area,
MunicipaiFire Stations YES | YES ty’e = | perimeter, Completed
P Ifiremun_
area,
MunicipalPoliceStations YES | YES |fax, juris, sub_sta |perimeter, Completed
Ipolimun_
ParkDistrict OK| YES | YES |[shape_area objectid Completed
Parks OK| YES | YES Completed
PoliceGrids OK| YES | YES Completed
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[Policestations ok| Yes | VES Completed
[Palis oK| YES | YES Completed
, area,
PrivateSchools OK{ YES | YES ix_coord,y _coord perimeter Completed
Schools OK| YES | YES Completed
. . objectid,
SectionBoundaries OK{ YES | YES |shape_area shape_leng Completed
. objectid,
SenateDistricts OK| YES | YES |shape_area shape leng Completed
. objectid,
TeamMetroBoundaries OK{ YES | YES shape_area shape_leng Completed
TeamMeatroOffices OK| YES | YES Completed
Completed Standard
TeamMetroRegionalOffices YES | YES |ofcname, zip area, ltmetro_lor Arclnfo fields. May be
perimeter  (Itmetro_id deleted or kept
cong area,
USHouseOfRepresentatives OK{ YES | YES |shape_length, perimeter,
pushouse_
shape_area
PIDES/PHYSICAL - .- P ST
Canals OK| YES | YES Completed
Coast OK| YES | YES Completed
NO INFORMATION. NEED
Contours NO NO acontour_i acontour_  |TO BE REQUESTED
FROMITD
CountyBoudary OK| YES | YES Completed
island, area, '
CountyOutline YES | YES |shape_length, perimeter, poutling i gg{“rzggzds aA{rC|r[1)f:l2t&:§-
shape area poutline y.
FloodHazardZones OK| YES | YES Completed
NO INFORMATION. NEED
FloodZanes NO NO TO BE REQUESTED
FROM ITD
HurricaneEvacuationZenes OK| YES | YES Completed
Hydrology OK| YES | YES Completed
Lakes OK| YES | YES Completed
Shoreline OK| YES | YES Completed
SoilConservation OK| YES | YES Completed
NO INFORMATION. NEED
Streams NO NO TO BE REQUESTED
FROMITD
PIDES/ SOCIOECONOMIC™ =~~~ - .o ‘
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Autes_Employment_and_economic_ran

king YES | YES Completed
NO INFORMATION. NEED
CansusBlockFromSirests NO NO TO BE REQUESTED
FROMITD
NO INFORMATION. NEED
CensusBlockGroups No | No [Sfapefength, - pbkare. TO BE REQUESTED
pe- POKGTP] FROM ITD
NO INFORMATION. NEED
CensusBlocks NO NO TO BE REQUESTED
FROM ITD
« shape lenath. 2782 NO INFORMATION. NEED
CensusBlocksFromStraetNetwork NC NO s'ha epa?ea g, perimeter, pdadeblk_i (TO BE REQUESTED
pe_ pdadeblk_ FROM ITD
CensusPlaces OK| YES | YES |shape area pcenspla_ Completed
shaoe le 1, objectid_1, obiectid 12* Completed Renamed to
CensusTracks YES NO  |shape_length, shape_leng, orjob'ecﬂ g CensusTracts. Objectid
shape_area shape_le_1 ) deleted
shape le 1, objectid 1, obiectid 12* NO INFORMATION. NEED
CensusTracksCoastling NO NO  Ishape_length, shape_leng, or} obiectid tracts id |TO BE REQUESTED
shape_area shape_le_1 y FROMITD
22§F_1999 _pop_and_housing fsutms_d YES NO Rename?
NO INFORMATION. NEED
MetropolitanStatisticalAreas NO NO TO BE REQUESTED
FROMITD
VehicleRegistration YES | YES Completed
. . area,
pzipcode |, zip, erimeter
Zipcodes OK| YES | YES |shape_length, pzi codes Completed
shape_area pzip =
_ pzipcodes i
TRANSYS/TI S R T e T
BikeLanes OK| YES | YES Completed
BikePaths OK| YES | YES |shape_length Completed
elevation Completed Elevation and
BikeWays YES | NO thickness’ Thickness fields do not
have info. Deleted
Completed Lat (latitude)
. and Lon (longitude) fields
BusRouteswithBikeRacks YES | YES lat, lon do not have info. Can be
deleted
Completed Similar to
i
DadeRoads YES | YES MajorRoads Deleted
FDOTBaseMap YES | YES Completed
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FLIntraStateHighwaySystem YES | YES |shape_length road_ Completed Deleted
FloridaintraStatetlighwaySystem YES | YES |shape_length road_ Completed
Iploy_,
usroute, stroute, rpoly,
FloridaStateRoads OK| YES | YES |descript, class, iength, Completed
shape_length majrds_,
majrds_id
FunctionalClassifications YES | YES Completed
Highways OK| YES | YES Completed
IntermodalFacilities_points OK| YES | YES Complsted
IntermodalFacilities_poly OK| YES | YES Completed
LacalStreetNames OK| YES | YES Completed
I zip, r_zip,
fig1, fig2, [Completed Standard
MajorRoads YES | YES mun, grid, |Arcinfo fields. May be
irss, cens, |deleted or kept
waste?
StateRoads OK| YES | VYES Completed
Completed Standard
StreetNetwork YES | YES figt, flg2  |Arcinfo fields. May be
deleted or kept
TrafficSignalsFDCT OK| YES | YES Completed
TrafficSignalsMDITD OK| YES | YES Completed
TrafficSignalsMDPW OK| YES | YES Completed
TRANSYS / TM_H LR T TR e
AADT OK| YES | YES Completed
FDOTDistricts OK| YES | YES |[shape_area Completed
FedAidHwySystem OK! YES | YES Completed
objectid,
MaxSpeed OK| YES | YES [shape_length shape.leng Completed
_ |prcimpet i, fif_distr, a::i?;]eter
RoadimpactFeeDistricts OK| YES | YES [shape_length, pr dimoct ' Completed
shape_area praimpet.
prdimpct i
SRCapacity OK| YES | YES Completed
rd_status,
SRFunctional Classifications OK| YES | YES |highmeasur, Caompleted
county, section
SRWPSectionlmprovement OK| YES | YES |shape_length id Completed
SRWPStructuralimprovement OK| YES | YES Completed
TrafficAnalysisDistricts OK| YES | YES |shape_area Completed
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route, rtype,
shape_length

TrafficAnalysisZones1992 OK| YES | YES |[shape area Completed
acres, shape_leng,
TrafficAnalysisZones2000 OK| YES | YES |[shape length, rev2kiz_ Compleied
shape_area
TrafficCountStations OK| YES | YES Completed
TRANSYS / TM_OM o SR
AirFacilties OK| YES | YES [tower type Completed
SpecialTransportationServices OK|{ YES | YES Compleied
TRANSYS/TM_PT. R e el
NO INFORMATION. NEED
BusMaintenanceFagilities NO NO TO BE REQUESTED
FROMITD
BusRoutes OK| YES | YES Completed
X coord Compleied X and Y
BusStops YES | YES |y_coord eoor dl coordinates. May be
Y- deleted or kept
MetroMover OK| YES | YES |[shape length Completed
NO INFORMATION. NEED
MetroMaverBoarding NO NO TO BE REQUESTED
FROM ITD
NO INFORMATION. NEED
MetroMoverMaintenanceF acilities NO | NO TO BE REQUESTED
FROM ITD
area, « coord Completed X and Y
MetroMover Stations YES | YES [code, name perimeter, coor d' coordinates. May be
Immovrst_i y deleted or kept
MetroRail OK| YES | VES amrai_and Completed
amrail_id
NO INFORMATION. NEED
MetroRailMaintenanceFacilities NO NO TO BE REQUESTED
FROM ITD
MetroRailStations OK| YES | YES Completed
: , o , Completed. Standard
Railroads ves | ves [Malaailid, lipoly, rpoly, jarail_and Arclnfo fiekds. May be
shape_length length arail_id
deleted or kept
rpoly, length,
Tri-Rail ok | ves | ves [airai, atirail Completed
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A4. Symbolized Layer Creation

Feature Class Layer(s) Created Metadata Convert to HTML

Pides | Developmental

CableTVServiceAreas CableTVServiceAreas YES YES
MobileHomeParks MobileHomeParks YES YES
Telecommunications Telecommunications YES YES
Pides | Environmental

Dumps Dumps YES YES
HurricaneEvacuationZones HurricaneEvacuationZones-Evac_Color YES YES
HurricaneSheiters HurricaneShelters YES YES
Wellfieids Wellfields YES YES
Pides | Institutional

Calleges Colleges-Type; Colleges YES YES
CommissionDistricts CommissionDistricls-Name YES YES
CommunityCouncils CommunityCouncils-Name YES YES
County Boundary CountyBoundary YES YES
DCFAdultFacilities DCFAdultFacilities YES YES
DCFDayCareCenters DCFDayCareCenters YES YES
DCFFacilities DCFFacifities YES YES
DCFHeadstartProjects DCFHeadstartProjects YES YES
DCFHealthDepartment DCFHealthDepariment YES YES
DCFNursingHomes DCFNursingHomes YES YES
DCFWamenInfChitdCenters DCFWomenlInfChildCenters YES YES
DCFWomenlInfChildVendors DCFWomenlIniChildVendors YES YES
EmpowZoneCensus EmpowZoneCensus-Name YES YES
Fire DepartmentGrid FireDepartmentGrid YES YES
FireStations FireStations YES YES
Hospitals Hospitals YES YES
HouseDistricts HouseDistricts-House YES YES
Libraries Libraries YES YES
Majorheighborhood MajorNeighborhood-Name YES YES
MDFire_RescueStationResponseOrder MDFire_RescueStationResponseOrder YES YES
MDFireBoardDistricts MOFireBoardDistricts-Dist YES YES
MOFireRescueResponseServiceAreas MDFireRescueResponseServicesAreas YES YES
MOFireStationSuppressionResponseServices MDFireStationSuppressionResponseServices YES YES
MDParks MOParks YES YES
MPoliceDistricts MDPoliceDistricts-Districls N YES YES
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MDPolicePatrolAreas MDPolicePatrolAreas-PatroiAreaNumbers YES YES
MDSolidWasteManagementGarbagePickup MDSolidWasteManagementGarbagePickup YES YES
MOWASAServiceAreas MDWASAServiceAreas-Code YES YES
MunicipalBoundaries MunicipalBoundaries-Munic_Name YES YES
“MunicipalFireStations MunicipalFireStations YES YES
MunicipalPoliceStations MunicipalPoliceStations YES YES
ParkDistricts ParkDistricts-DistrictNumbers YES YES
Parks Parks YES YES
qPoliceGrids PoliceGrids YES YES
PoliceStations PoliceStations YES YES
PalingPrecincs Palingpredins House, PalingPracinas. Commisson Yes ves
LPolls Palls YES YES
PrivateSchools PrivateSchools YES YES
Schools Schools YES YES
SectionBoundaries SectionBoundaries YES YES
SenateDistricts SenateDistricts-Senate YES YES
TeamMetroBoundaries TeamMetroBoundaries-Offices YES YES
TeamMetroOtfices TeamMetroOffices YES YES
TeamMetroRegionalOffices TeamMetroRegionalOffices YES YES
USHouseOfRepresentatives USHouseOfRepresentatives-HouseDistriciNos YES YES
Pides | Physical
Canals Canals YES YES
Coast Coast-CountyName YES YES
Contours Countours YES YES
CourtyBoundary CountyBoundary YES YES
CountyQutline CountyQutline YES YES
FloodHazardZones FloodHazardZones-Elev YES YES
FloodZones FloodZones-Dig_Pannum YES YES
HurricaneEvacuationZones-Evac_Color;
HurricaneEvacuationZones HurricaneEvacuationZones-Hurr_Caleg YES YES
Hycrology Hydrology YES YES
Lakes Lakes YES YES
Shoreline Shoreline YES YES
ScilConservation SoilConservation YES YES
Streams Streams YES YES
Pides | SocioEconomic
AulosEmploymentAndEconomicRanking
BlocksG1it BlocksOift YES YES
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CensusBlockFromStreets CensusBlockFromStreets YES YES
CensusBlockGroups CensusBtockGroups YES YES
CensusBlocks CensusBlocks YES YES
CensusBlocksFromStreeiNetwork CensusBlocksFromStreetNetwork YES YES
CensusPlaces CensusPlaces YES YES
CensusTracksCoastline CensusTracksCoastline YES YES
CensusTracts CensusTracts YES YES
MetropolitanStatisticalAreas MetropolitanStatisticalAreas YES YES
Zipcodes Zipcodes YES YES
TransSys | TI
Bikel.anes BikeLanes YES YES
BikePaths BikePaths YES YES
BikeWays BikeWayConditions YES YES
BusRouteswithBikeRacks BusRouteswithBikeRacks YES YES
FDOTBasemap FDOTBasemap YES YES
FloridalntraStateHighwaySystem FloridalntraStateHighways YES YES
FloridaStateRoads FloridaStateRoads YES YES
FunctionalClassFederalRural;
FunctienalClassifications FunctionalClassFederalUrban YES YES
Highways Highways YES YES
IntermodalFacilities_points; IntermodalFacilities_points-
IntermodalFacilities_points Type_of TE YES YES
IntermadalF acilities_poly IntermodalF acilities_poly YES YES
LocalSireetNames LocalStreetNames YES YES
MajorRoads; MajorRoads-Truck_Code; MajorRoads-
MajorRoads Funclass YES YES
StaleRoads StateRoads YES YES
StreetNetwork StreetNetwork YES YES
TeafficSignalsFOOT TrafficSignalsFDOT YES YES
TrafficSignalsMOITD TrafficSignalsMDITD; TrafficSignalsMDITD-TimingZ one YES YES
TrafficSignalsMDPW TrallicSignalsMDPW YES YES
TransSys | TM H
AADT RoadAADT; RoadCapacity24Hr YES YES
FatalCrashes1997_1989 FatalCrashes1997_1999_byNoKilled YES YES
FOOTDistricts FDOTDistricts; FDOT Districts-District YES YES
FedAidHwySystem FedAidHwySystem YES YES
MaxSpeed MaxSpeed; MaxSpeed-MaxSpeed YES YES
RoadlmpactFeeDistricts RoadimpactFeeDistricts-Rif_Distsi YES YES
SRCapacity SRCapacity YES YES
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SRFunctionalClassification-ClassificaRural:

SRFunctionalClassification SRFunctionalClassification-Classificalrban YES YES
SRWPSectionimprovement; SRWPSection|mprovement-
SRWPSectionlmprovement Specif, SRWPSectionlmprovement-Year YES YES
SRWPStructurallmprovements;
SRWPStructurallmprovements-Comments;
SRWPStructurailmprovements SRWPStructuralimprovements-Date YES YES
TrafficAnalysisDistricts TralficAnalysisDistricls YES YES
TrafficAnalysisZones1992; TrafficAnalysisZones1992-
TrafficAnalysisZones 1992 District YES YES
TrafficAnalysisZones2000 TrafficAnalysisZones2000 YES YES
TrafficCountStationsF DOTPoinlLocations TrafficCountStationsF DOT PointLocations YES YES
TrafficMoniloringStationsF DOTLineSegments [No spatial reference. Read-only feature class ]
TransSys | TM OM
Airfacilities; Airfacilities-CongestionLevel; Airfacilities-
AirFacilities Name; Airfacilities-Owner; Airfacilities- Use YES YES
SpecialTransportationServices-Zone;
SpecialTransportationServices SpecialTransportationServices-ZoneQuantities YES YES
TransSys\TM PT
BusMaintenanceFacilities; BusMaintenanceFacilities-
{BusMaintenanceF acilifies Name YES YES
BusRoutes BusRoutes YES YES
BusStops BusStops YES YES
MetroMover MetroMover YES YES
MetroMoverBoarding MetroMaverBoarding-Annual YES YES
MetroMoverMaintenanceFacilities MetroMoverMaintenanceF acilities YES YES
MetroMaoverStalions MetroMoverStations YES YES
MetroRail MeiroRail YES YES
MetroRailMaintenanceFacilities MetroRailMaintenanceF aciliies YES YES
MetroRailStations MetroRailStations YES YES
Railroads RailRoads YES YES
Trirail Trirail YES YES
FSUTMS | TAZ19994Analysis
AdjustedincomeData TAZ1999-AdjustedincomeData YES YES
TAZ1999-CarsByHousingType-MF_1Car; TAZ1999-
CarsByHousingType-MF_2Cars; TAZ1999-
CarsByHousingType-MF_NoCars; TAZ 1999-
CarsByHousingType-SF_1Car; TAZ1999-
CarsByHousingType-SF_2Cars; TAZ1999-
CarsByHousingType CarsByHousingType-SF NoCars YES YES
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CBD_ExUrbanData TAZ1999-CBD_ExUrbanData YES YES
EmploymentData TAZ1999-EmploymentData-TotalEmployment YES YES
TAZ1999-HotelMotelData-HotelOcc; TAZ1999-
HotelMotelData-HotelRes; TAZ1999-HotelMotelData-
HotelMotelData HotelRoom YES YES
HouseholdData TAZ1999-HouseholdData-TotalHouseholds YES YES
HousingData TAZ1999-HousingData-TotalHousing YES YES
OccupiedRocmsData TAZ1999-OccupiedRooms Data-Cec_Rooms YES YES
TAZ1999-PersonData-W_Children; TAZ1999-
PersonData PersonData-W_NoChild YES YES
PopulationData TAZ1999-PopulationData-TotalPopulation YES YES
SchoolEnrolimentData TAZ1999-SchoolEnrollData-Sch_Enroll YES YES
TrafficAnalysisZones1992 YES
TAZ1999-VehicieData-V_Children; TAZ1999-
VehicleData VehicleData-V_NoChild YES YES
TAZ1999-WorkerData-W_Children; TAZ1999-
WorkerDala WorkerData-W_NoChild YES YES
FSUTMS | TAZ2000Analysis
AdjustedincomeData TAZ2000-AdjustedincomeData-Inc_Adj199 YES YES
TAZ2000-CarsByHousingType-MF_1Car; TAZ2000-
CarsByHousingType-MF_2Cars; TAZ2000-
CarsByHousingType-MF_NoCars; TAZ2000-
CarsByHousingType-SF_1Car, TAZ2000-
CarsByHousingType-SF_2Cars; TAZ2000-
CarsByHousingType CarsByHousing Type-SF_NoCars YES YES
EmpioymentDala [unknown fields]
TAZ2000-HotelMotelData-Hotel_Occ; TAZ2000-
HotelMotelData-Hotel_Res; TAZ2000-HotelMotel Data-
HotelMotelDala Hotel_Room YES YES
HousingData TAZ2000-HousingData-Tot_Housin YES YES
PopulationData TAZ2000-PoputationData-Pop_Total YES YES
SchoolEnrolimentData TAZ2000-SchoolEnrolimentData-Sch_Enrolt YES YES
TAZ2000-SchoolsData-Elem_Enrol; TAZ2000-
SchoolsData-High_Ensol; TAZ2000-SchoolsData-
SchoolsData Midd_Enrol, TAZ2000-SchoolsData-Priv_Enrol YES YES
FSUTMS | TAZ2000Analysis \ 2015Projections
AdjustedincomeData TAZ2000-2015P-AdjustedincomeData-Inc_Adj201 YES YES
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TAZ2000-2015P-CarsByHousingType-MF_1Car:
TAZ2000-2015P-CarsByHousingType-MF_2Cars:
TAZ2000-2015P-CarsByHousing Type-MF_NoCars:
TAZ2000-2015P-CarsByHousingType-SF_1Car;
TAZ2000-2015P-CarsByHousing Type-SF_2Cars;

CarsByHousingType TAZ2000-2015P-CarsByHousingType-SF_NoCars YES YES
CBD_ExUrbanData TAZ2000-2015P-CBD_ExUrbanData YES YES
EmploymentData TAZ2000-2015P-EmploymentData-Total_Emp15 YES YES
TAZ2000-2015P-HotelMotelData-Hatel_Ccc;
TAZ2000-2015P-HoteiMotelData-
Hotel_Res;TAZ2000-2015P-HoleiMotelData-
Hote!MotelData Holel_Room YES YES
TAZ2000-2015P-HouseholdData-H_Children;
HouseholdData TAZ2000-2015P-HouseholdData-H_NoChild YES YES
HousingData TAZ2000-2015P-HousingData-Tot_Housin YES YES
OccupiedRoomsDala TAZ2000-2015P-OccupiedRoomsData YES YES
TAZ2000-2015P-PersonData-P_Children; TAZ2000-
PersonDala 2015P-HousingData-P_NoChild YES YES
PopufationData TAZ2000-2015P-PopulationData-Pop_Total YES YES
SchoolEnrollmentData TAZ2000-2015P-SchoolEnrolimentData YES YES
TAZ2000-2015P-SchootsData-Elem _Enrof; TAZ2000-
2015P-SchooisData-High_Enral; TAZ2000-2015P-
SchoolsData-Midd_Enrol; TAZ2000-2015P-
SchoolsData SchoolsData-Priv_Enrol YES YES
TAZ2000-2015P-VehicleData-V_Children; TAZ2000-
VehicleData 2015P-VehicleData-V_NoChild YES YES
TAZ2000-2015P-WorkerData-W_Children; TAZ2000-
WorkerData 2015P-WorkerData-W NoChild YES YES
FSUTMS | TAZ2000Analysis | 2025Projections
AdjustedincomeData TAZ2000-2015P-AdjustedincomeData-Inc_Adj202 YES YES
TAZ2000-2025P-CarsByHousingType-MF_1Car;
TAZ2000-2025P-CarsByHousingType-MF_2Cars;
TAZ2000-2025P-CarsByHousingType-MF_NoCars:
TAZ2000-2025P-CarsByHousingType-SF_1Car,
TAZ2000-2025P-CarsByHousingType-SF_2Cars;
CarsByHousingType TAZ2000-2025P-CarsByHousingType-SF_NoCars YES YES
CBD_ExUrbanData TAZ2000-2025P-CBD_ExUrbanData YES YES
EmploymentData TAZ2000-2025P-EmploymentData-Tolal Emp15 YES YES
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TAZ2000-2025P-HotelMotel Data-Hotel_Occ;
TAZ2000-2025P-HatelMotelData-
Hotel_Res; TAZ2000-2025P-HotelMotelData-

HotelMotelData Hotel_Room YES YES
TAZ2000-2025P-HouseholdData-H_Children:

HouseholdData TAZ2000-2025P-HouseholdDiata-H_NoChild YES YES

HousingData TAZ2000-2025P-HousingData-Tot_Housin YES YES

QOccupiedRoomsData TAZ2000-2025P-OccupiedRoomsData YES YES
TAZ2000-2025P-PersonData-P_Children; TAZ2000-

|PersonData 2025P-HousingData-P_NoChild YES YES

PopulationData TAZ2000-2025P-PopulationData-Pop_Total YES YES

SchoolEnrolimentData TAZ2000-2025P-SchooiEnralimentDala YES YES
TAZ2000-2025P-SchoolsData-Elem_Enrol: TAZ2000-
2025P-SchoolsData-High_Enrol; TAZ2000-2025P-
SchoolsData-Midd_Enrol: TAZ2000-2025P-

SchoalsData SchoolsData-Priv_Enrol YES YES
TAZ2000-2025P-VehicleData-V_Children; TAZ2000-

VehicleData 2025P-VehicleData-V_NoChild YES YES
TAZ2000-2025P-WorkerData-W_Children; TAZ2000-

WorkerData 2025P-WarkerData-W NoChild YES YES
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